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1 Introduction
Overview of Installation and Licensing

Welcome to Maya 6.5!

This guide describes the process of installation and licensing 
Maya 6.5 for all supported platforms, along with some 
information about troubleshooting your installation and licensing 
problems. Please follow your platform-specific installation 
instructions:

• ”Installing Maya for Windows” on page 13

• ”Installing Maya for Mac OS X” on page 31

• ”Installing Maya for IRIX” on page 43

• ”Installing Maya for Linux” on page 63

You can also install a special version of mental ray (satellite) for 
network rendering on computers that are accessible via a local 
network to the machine running Maya:

• ”Installing mental ray (satellite)” on page 79

When you have finished installing Maya, proceed to the licensing 
chapter.

• ”Licensing Maya” on page 85

If you have problems starting or licensing Maya, please review 
our troubleshooting guide.

• ”Troubleshooting” on page 127

The Maya 6.5 installation and licensing process is available in 
Japanese for Windows and Mac OS X. The installation and 
licensing process will take place automatically in Japanese on a 
Japanese-language Windows or Mac OS X system. 
Installation and Licensing Guide
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1 | Introduction 
 > Overview of Installation and Licensing
This guide also contains the Terms and Conditions for your use of 
Maya. Please review them.

• ”Software terms and conditions” on page 159
Installation and Licensing Guide 
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2 Installing Maya 
for Windows

Overview of installing Maya for Windows

This chapter describes how to install Maya for Windows, as well 
as the hardware and system requirements for running Maya on a 
Windows operating system.

Before you begin

• Your computer system must meet specific requirements in 
order for you to successfully install and run Maya. Alias does 
not support hardware and software configurations that do not 
meet these requirements. Please take a few moments to 
review the following hardware and software requirements 
section. 

• You must have administrator privileges to install Maya. You 
do not need to be an administrator to launch Maya once it is 
installed.

• Make sure you meet the disk space and other requirements by 
reviewing ”System requirements” on page 14.

• You can keep or uninstall previous versions of Maya. 
However, you must uninstall if you are installing the same 
Maya version as the one installed (for example, a pre-release 
copy). See ”Uninstalling Maya” on page 27.

Note The most up-to-date information on specific hardware 
system qualifications for your computer can be found on 
the Alias Web site:

www.alias.com/qual_charts
Installation and Licensing Guide
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2 | Installing Maya for Windows 
 > System requirements
• Exit all other programs before you launch the installer. You 
should also temporarily disable any virus detection software 
that is installed on your computer during the installation.

• You must run the installer on each computer where you want 
to run the software. If you’re going to use a computer to serve 
licenses, you must also run the installer on that computer.

System requirements

Alias certifies certain computer system configurations as meeting 
the requirements to work with the Maya software. To determine 
whether your particular system meets these requirements, please 
check the qualification charts for the latest information at 
www.alias.com/qual_charts.

The system requirements are categorized as follows:

• Hardware and memory requirements—page 15

• Operating system requirements—page 15

• Graphics requirements—page 16

• Disk space requirements—page 18

• Other software—page 18

• Optional hardware—page 19

Note Having multiple versions of Maya installed on a 
machine and adding each version’s path to the users 
environment PATH variable may cause version 
conflicts. 

Only add the path currently needed for the version of 
Maya that is being run. Under most circumstances Maya 
performs correctly if the path is not set.
Installation and Licensing Guide 
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2 | Installing Maya for Windows

 > System requirements
Examining system capabilities

You can examine your system capabilities using system diagnostic 
tools. Select Start > Programs > Accessories > System Tools > 
System Information.

Hardware and memory requirements

The minimum hardware requirements for running Maya on a 
Windows computer are as follows: 

• Pentium II processor or higher with at least 200 MHz for 
Windows 2000 Professional and at least 300 MHz for 
Windows XP Professional, Pentium 4 or AMD Athlon 
strongly recommended

• 256MB RAM, 512MB or more recommended

• CD-ROM drive

• A qualified hardware-accelerated OpenGL graphics card 
(overlay plane capability is recommended) Please refer to:

www.alias.com/qual_charts

• an Ethernet card (You can also use a hardware lock, which 
can be purchased through Alias.)

• Keyboard

• Three-button mouse with mouse driver software

Operating system requirements

• Windows 2000 Professional, or Windows XP Professional 
with appropriate Service Pack. 

Note Alias certifies combinations of processors, operating 
system versions, graphics cards and drivers for 
operation with Maya. For details, see www.alias.com/
qual_charts for the latest information.
Installation and Licensing Guide
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2 | Installing Maya for Windows 
 > System requirements
• TCP/IP network protocol software (for running Maya batch 
rendering and other features).

• Graphics card driver. Driver software is available from the 
manufacturer’s web site.

• Appropriate driver software for optional hardware.

Graphics requirements

• A graphics card qualified to run Maya. Please refer to:

www.alias.com/qual_charts

Options in the Display Properties settings of Windows affect the 
display performance of Maya. To learn the correct option settings 
for graphics cards qualified for use with Maya, please check the 
qualification charts for the latest information. Also see the 
Readme file on your installation CD for any last minute updates.

Some major graphics card manufacturers have created a single 
option that you can turn on to optimize Maya display 
performance. If this option exists, it is available through the 
Windows Display Properties settings. Contact your graphics card 
manufacturer to see if their latest graphics software provides this 
option.

If you’re using a card that’s not qualified, do the following steps. 
(Some steps offer only general guidelines because each 
manufacturer has a unique set of display options.)

Note Many graphics card manufacturers document the setup 
of their graphics card for use with Maya. Refer to the 
instructions that came with your particular graphics 
card.
Installation and Licensing Guide 
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2 | Installing Maya for Windows

 > System requirements
To set your graphics card options

1 Right-click your desktop, select the Settings tab and click the 
Advanced button.

2 From the Color Palette menu, select True Color. This specifies 
24 or 32 bits of color for best color quality in displayed 
images.

3 Drag the Desktop Area slider to the best display resolution 
supported by your hardware. The higher you set the display 
resolution, the more graphics card main memory you need. 
This is called VRAM on some computers. 

Maya generally works best at 1280 by 1024 resolution. If 
you’ve selected True Color and your card has limited VRAM, 
it will work better at a lower resolution. (At the higher 
resolution, the card may run out of memory, forcing the 
OpenGL driver to operate in software mode rather than use 
hardware acceleration.) 

After you install your graphics card driver software, it’s likely 
that a tab named for the card was created in the Display 
Properties window. The tab has performance options that 
vary with each card. On Windows 2000 and Windows XP, 
click the Advanced button and select the appropriate tab.

Graphics performance options

The following are general suggestions for setting performance 
options:

1 In the Display Properties window, click the tab named for 
your graphics card (if available).

2 Turn on the overlay plane feature (if available).

Maya takes advantage of the hardware overlay plane feature 
available with most mid- and high-quality OpenGL graphics 
cards. In brief, overlay planes enable programs to quickly 
display certain elements of a user interface that exist on top of 
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other elements, without having to redraw the entire user 
interface. Overlay planes are called hardware overlays on 
some products.

Maya works with four-bit or greater overlay planes, single- or 
double-buffered. For some graphics cards, overlay planes are 
available only if you turn off alpha planes operation. Because 
stencil planes are not required by Maya, you can turn them 
off. 

3 Close the Display Properties window.

Disk space requirements

The following approximate disk space requirements are based on 
the NTFS disk format. If you have a FAT disk format, expect 
slightly larger file sizes. These are default, minimal sizes; you’ll 
need more space to install optional selections.

• NTFS: 375MB for Maya Unlimited (including 100MB for Maya 
documentation)

• FAT: 400MB for Maya Unlimited (including 115MB for Maya 
documentation)

• Maya Complete is 20MB smaller

• 30MB of temporary space on the C: drive to start the installer 

• 110MB for the Shader Library

Other software

• Adobe Acrobat Reader version 5.x or later is required to view 
the PDF documentation provided on the Documentation, 
Lessons, and Extras CD. If Adobe Acrobat Reader is not 
currently installed on your computer, it can be downloaded 
from the Adobe Web site (www.adobe.com).

• Netscape 6+ and Internet Explorer 5+ web browsers have 
been qualified to view the Maya Help. 
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Optional Hardware

• Wacom tablet—The Wacom tablet works the same as with 
other programs. Using the pen and tablet overrides mouse 
operation. When the pen is out of contact with the tablet, the 
mouse becomes operational. Make sure you install the latest 
driver software (www.wacom.com).

• Motion capture devices—Maya supports real-time motion 
capture. Contact your motion capture equipment vendor for 
details.

Installing Maya

For information on the other installation options, see the 
following:

• ”Installing the Maya Shader Library” on page 26

• ”Uninstalling Maya” on page 27

• ”Maya Plug-ins” on page 26

• ”Bonus Tools” on page 27

To install Maya for Windows

1 Insert the Maya Software CD into your CD-ROM drive.

The Maya installer window appears.

If the Maya installer does not appear, choose Start >Run. Click 
Browse and choose the Autorun.exe file on the Maya CD 
(this is generally D:\Autorun.exe). Click OK in the Run 
dialog box to begin the installation.
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2 Click Install Maya to begin the software installation and 
follow the online instructions.

The Maya Installation Wizard appears. The installation 
wizard directs you through the process of installation. Click 
Next to proceed through the installation, Back to return to the 
previous window, or Cancel to stop the installation.

3 Click Next.

The Maya Software License Agreement and Documentation 
Server License Agreements appear. These agreements require 
your acceptance in order for the Maya software installation to 
continue. If you do not agree to the terms and conditions of 
the agreements, the installation process does not continue.

4 Click “I accept the terms....”and click Next to continue with 
the Maya software installation.

The Customer Information window appears.

5 Enter your name and the name of your organization in the 
text box, and then click Next.

The Product Configuration window appears.
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6 On the Maya Product Configuration screen, you can set three 
options: 

• Maya Complete or Unlimited

Select the Maya product you purchased from the choices 
presented (Complete or Unlimited).

• Full or Custom Install

The Full setup installation is the recommended installation for 
most users. It installs the Maya application, all related 
applications and utilities, and sets the file type associations on 
your computer for Maya file types automatically.

If you want to install specific components of the Maya 
application, for example, the Maya developer features, modify 
the default file associations, or want to turn off items in the 
installation to save disk space, choose Custom setup from the 
menu. 

• Where to install Maya.

If you want to change the default location for the software 
installation, click Change. The Windows browser appears. 
Browse to the install location or enter the path. 
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• Choose Full to select a Full setup Maya installation 
(recommended), click Next, and proceed to step 9.

• Choose Custom. click Next, and proceed to the next step. 

7 (Custom Installation only.) The Feature Selection window 
appears.

You can select specific components of the Maya application 
for installation in the Feature Selection window. You can turn 
off some items in the installation to save disk space.

By default, all options for Maya Complete or Maya Unlimited 
are turned on. If you want to turn off an item so it does not 
install, click the down arrow icon in the list and select the X 
from the submenu (this feature will not be available).

At a minimum, you must install the following to run Maya:

• Maya Program Files—contains the core Maya software. 
This option can’t be turned off.

• Licensing—includes files essential to the subsequent 
licensing procedure.
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The remaining items are optional for a custom installation. If 
you’re trying to conserve disk space, you can turn them off.

• Maya Unlimited—Optional modules for Maya Unlimited 
if you purchased it (Maya Cloth, Maya Fur, Maya Live, 
Fluids).

• Maya Documentation— Software to run the Maya online 
documentation and files for Maya’s online 
documentation.

• Maya Developer Toolkit—Software that lets you work 
with the Maya API to write and edit plug-ins.

From this window, you can also click Help to get Custom 
Setup Tips or click Space to check available space on 
connected hard drives. 

When you are ready to proceed, click Next.

8 (Custom Installation only.) The File Type Handling window 
appears.

Note If you are installing on a computer that serves Maya 
licenses to other computers but won’t be used to run 
Maya itself, you can save disk space by turning off 
everything except Licensing.
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You can set how various file format types are handled on 
your computer using the options in this window. For 
example, if you double-click a Maya binary scene file (.mb), 
the computer automatically launches Maya based on the file 
type association that had been set. Depending on the other 
software you have configured on your computer, you can 
either leave these options enabled as is, or change them to suit 
your particular setup.

When you are ready to proceed, click Next.

9 (Full or Custom Installation.) The Add Location To Path 
window appears. Three options in this window are turned on 
by default.

• Add a Shortcut to the Quick Launch Toolbar—Adds a 
Maya shortcut icon to your Windows Quick Launch 
Toolbar.

• Add to System Path—Adds the Maya executable 
directory to your Windows system path. This lets you 
start Maya or any of its related programs from any 
directory when using the command prompt; for example, 
at the command prompt, you could simply enter maya to 
launch Maya or fcheck to launch the FCheck image-
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viewing utility. Setting the system path may also be useful 
for batch files and other scripts involving Maya or other 
related programs.

• Add a Shortcut to the Desktop—Adds the Maya shortcut 
icon to your desktop during the installation.

Make your selections and click Next.

10 The Ready to Install the program window appears. If you 
want to review or change any of your installation settings, 
click Back; otherwise, click Install.

The Maya software and accompanying utilities are installed 
on your computer. The progress of the installation is indicated 
by the progress bar at the bottom of the installer’s window.

11 Continue with the license setup program after the software 
installation: 

• If you’re an existing Maya customer, your license may 
already be installed for you. 

• If you’re a new Maya customer, start the Product 
Configuration Wizard after installation by choosing Maya 
from the Windows Start menu.

• If you’re setting up a license server, see Chapter 7, 
“Licensing Maya” for details of how to set up both servers 
and clients.

For more information, see Chapter 7, “Licensing Maya”.

Note If you are licensing your computer using a parallel port 
or USB hardware lock, you may need to reboot your 
computer in order for the licensing process to detect 
your hardware lock. For more information, see 
”Licensing: Hardware lock devices” on page 28 and 
Chapter 7, “Licensing Maya”.
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Installing the Maya Shader Library

You can either install the Maya Shader Library at the time you 
install the Maya software or install it later on. The Shader Library 
requires approximately 110MB of disk space.

To install the Maya Shader Library for Windows

1 Insert the Maya software CD into your CD-ROM drive and 
click Install Shader Library when the Maya Installation 
window appears.

The Wizard Welcome window appears. 

2 At the Welcome dialog box, click Next.

The Maya Shader Library for Maya Read Me screen appears.

3 Read the contents of this dialog box and click Next.

The Wizard window options for installing the Shader Library 
appear.

4 If you want to change the destination folder, click the Change 
button. Click Next when ready.

By default, the Maya 6.5 Shader Library is installed in 
drive:\Program Files\Alias\MayaShaderLibrary.

5 At the Ready to Install dialog box, click Install.

The Shader Library files are copied to your system. When the 
Shader Library installation is finished the Installation 
Completed dialog box appears.

6 Click Finish when the installation is complete.

Maya Plug-ins

The Maya Plug-ins button provides a link to a variety of third-
party Maya Plug-in vendor Web sites. Plug-ins are software 
products that extend the functionality of your Maya software. For 
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more information on Maya Plug-ins and the Conductors program, 
click Maya Plug-Ins on the Maya Installer Window or see 
www.alias.com/conductors.

Bonus Tools

Bonus Tools is a collection of unsupported Maya scripts and plug-
ins provided to Maya users. The Bonus Tools button in the 
installer links to the Maya Bonus Tools on the Alias Web site. You 
can also access the Bonus Tools Web site from the Maya Help 
menu.

Follow the directions provided on the Web site for downloading 
and installing Bonus Tools on your computer.

After installing Bonus Tools, there is a drop-down menu for easy 
access to the tools that cover all aspects of everyday use: general 
UI, modeling, animation, texturing and rendering.

Uninstalling Maya

To ensure a clean installation, uninstall any existing copy of 
Maya 6.5 on your computer before reinstalling Maya 6.5.

To uninstall Maya for Windows using the Maya 
software CD

1 Insert the Maya software CD into your CD-ROM drive.

2 Click Uninstall Maya when the Maya Installation window 
appears.

3 Follow the instructions in the dialog box that appears.

To uninstall Maya for Windows using the Uninstall 
utility

1 From the Windows Start menu, select Programs > Alias > 
Maya 6.5 > Uninstall Maya.
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2 Follow the instructions in the dialog box that appears.

To uninstall Maya for Windows using the Windows 
Add/Remove programs utility

1 From the Windows Start menu, select Settings > Control 
Panels > Add/Remove Programs.

2 In the list programs that appear, click the Maya 6.5 
components.

3 Follow the instructions in the dialog box.

Installing Maya 6.5 alongside Maya 6 and 
previous versions

Maya 6.5 and previous versions of Maya can co-exist on the same 
machine. However, be aware of which version of Maya you are 
running. If you run the Render command in a terminal window, 
you should fully specify the directory path to be sure you are 
getting the version of the Maya renderer you expect.

Licensing: Hardware lock devices

The following instructions are necessary only for upgrading 
customers who choose to continue using hardware locks.

You can license your Maya software with an ethernet address 
(network card) or with a hardware lock (or dongle) on your 
machine. For more information on licensing, see “Licensing 
Maya” in Chapter 7.

Note Maya 6.5 supports USB hardware locks for Windows.
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A hardware lock (or dongle) is an encoded connector that attaches 
to the parallel port or USB port of your computer. A hardware 
lock allows you to run Maya on different computers (one 
computer at a time) without having to obtain a unique license for 
each computer. The software is licensed to the hardware lock 
device rather than a unique ethernet address.

If you’re installing a node-locked license, plug the hardware lock 
into the parallel port or USB port of the computer that receives the 
license. For more information about node-locked licenses, see 
“Licensing Maya” in Chapter 7.

If you’re installing a floating license, plug the hardware lock into 
the parallel port or USB port of the computer that serves licenses 
to client computers. (For more information about floating-locked 
licenses, see “Licensing Maya” in Chapter 7.) You do not plug a 
lock into client computers. When you choose a computer to 
operate as the license server, make sure it is stable and accessible 
to the clients in the network.

If you have a licensed version of Maya with a hardware lock, you 
can continue to use Maya with the hardware lock. If you plan to 
use the ethernet address instead of the hardware lock, you must 
contact Alias Sales Support to relocate it. You will also need to 
return your hardware lock to Alias.

Plug the lock into the computer before running the installer. Be 
careful not to force the lock into the parallel port or USB port 
incorrectly. Secure a parallel connector with the thumb screws so 
it won’t fall off and interrupt Maya operation.

The drivers to detect the hardware lock are installed when you 
install Maya. If you go through the licensing process and it fails to 
detect the hardware lock, please reboot.

To avoid damaging a lock, exit Maya or stop Maya license server 
operation before removing the lock. For details, see ”(Windows) 
To stop and start the license server” on page 113.
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If you install another Windows program that uses a parallel port 
hardware lock, plug the other lock into the back end of the 
installed Maya lock. The Maya lock must directly connect to the 
parallel connector. 

You may plug your printer or other parallel port devices into the 
parallel port hardware lock. In some cases, the lock might 
interfere with the flow of data between your computer and your 
printer. If you have trouble printing, temporarily remove the lock 
and plug the printer directly into the computer’s parallel 
connector.

If you are using a USB hardware lock, you can use it with a USB 
hub. However, there is no pass-through USB connection.
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for Mac OS X

Overview of installing Maya for 
Mac OS X

This chapter describes how to install Maya for Mac OS X as well 
as the hardware and system requirements for installing and 
running Maya on a Mac OS X computer.

Before you begin

• Your computer system must meet specific requirements in 
order for you to successfully install and run Maya. Alias does 
not support hardware and software configurations that do not 
meet these requirements. Please take a few moments to 
review the following hardware and software requirements 
section. 

• You must have administrator privileges to install Maya. This 
means that you need an administrator password on your 
computer to install Maya. You do not need to have 
administrator privileges to launch Maya once it is installed. 

• You can keep or uninstall previous versions of Maya. 
However, you must uninstall if you are installing the same 
Maya version as the one installed (for example, a pre-release 
copy). See ”Uninstalling Maya” on page 40.

Note The most up-to-date information on specific hardware 
system qualifications for your computer can be found on 
the Alias Web site:

www.alias.com/qual_charts
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• Exit all other programs before you launch the installer. You 
should also temporarily disable any virus detection software 
that is installed on your computer during the installation.

• You must run the installer on each computer where you want 
to run the software. If you’re going to use a computer to serve 
licenses, you must also run the installer on that computer.

System requirements

Alias certifies certain computer system configurations as meeting 
the requirements to work with the Maya software. To determine 
whether your particular system meets these requirements. Please 
refer to 

www.alias.com/qual_charts

The system requirements are categorized as follows:

• Hardware and memory requirements—page 33

• Operating system requirements—page 33

• Graphics requirements—page 34

• Disk space requirements—page 34

• Other software—page 34

• Optional hardware—page 35

Examining system capabilities

You can examine your system capabilities.

To examine the system capabilities of your Mac OS X 
computer

Do one of the following:

• From the Apple menu, select About this Mac and click the 
More Info button.
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• Double-click the Apple System Profiler application 
(Applications > Utilities).

Apple System Profiler provides information about your computer, 
operating system, disks, and applications.

Hardware and memory requirements

• Macintosh computer with at least a 450 MHz G4 processor

• 512MB memory (minimum)

• CD-ROM drive

• keyboard

• three-button mouse (recommended). 

Maya can work with mouse input devices that have fewer 
buttons. See the Environment Variables guide in the Maya Help 
for details of how to set Maya to work with different mouse 
input devices.

If your mouse came with a preference program for 
customizing mouse buttons, set it to deactivate when Maya is 
active. Refer to the manual or online help that came with your 
mouse to find out how to do this.

Operating system requirements

• Mac OS X version 10.3 or later.

• Mac OS X Server is not supported

Not all versions of Mac OS X can be used with Maya. Alias 
recommends that you refer to the qualification charts for your 
computer before upgrading to a newer version of operating 
system.

www.alias.com/qual_charts
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Graphics requirements

• A graphics card qualified to run Maya. Please refer to:

www.alias.com/qual_charts

Maya works best with a mid- to high-range, hardware-
accelerated OpenGL graphics card

• Set your display to show millions of colors

• If possible, set your resolution higher than 1024 by 768. Lower 
resolutions can make it difficult to see some attributes inside 
editors

• Check www.alias.com/qual_charts to see which operating 
system and graphics card combinations have been qualified 
for use with Maya

Disk space requirements

• A minimum of 440MB of available disk space

Other software

• Apple QuickTime and Preview (which reads PDF files) are 
provided with the Mac OS X operating system. You can also 
download Adobe Acrobat Reader at www.adobe.com.

These applications are required for viewing the multimedia 
movies provided with the Maya application and viewing the 
PDF documentation provided on the Documentation, Lessons, 
and Extras CD.

Note Many graphics card manufacturers document the setup 
of their graphics card for use with Maya. Refer to the 
instructions that came with your particular graphics 
card.
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• Safari, Internet Explorer 5+ and Netscape 6+ web browsers 
have been qualified to view the Maya Help.

Optional Hardware

• Wacom tablet—The Wacom tablet works the same as with 
other programs. Using the pen and tablet overrides mouse 
operation. When the pen is out of contact with the tablet, the 
mouse becomes operational.

Installing Maya

To install Maya for Mac OS X

1 Insert the Maya software CD into the CD-ROM drive of your 
computer.

The contents of the CD-ROM appear in a new Finder window.

2 Double-click the InstallMaya icon to begin the installation 
process.

The installer window appears. You can cancel the installation 
at any time by closing the installer window.

3 Click Continue to proceed with the Maya software 
installation.

Note You can also install the shader library. The shader 
library contains pre-defined materials you can apply to 
your models. See ”Installing the Maya Shader Library” 
on page 39.
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The Alias Software License Agreement appears (includes 
Maya Documentation Server License Agreement). You can 
print or save this License Agreement for future reference. This 
agreement requires your acceptance in order for the Maya 
software installation to continue. If you do not agree to the 
terms and conditions of the agreement, the installation 
process does not continue.

4 Click Continue and then Accept to continue with the Maya 
software installation.

5 In the Select a Destination screen, select the volume where 
you want Maya to be installed. 

By default, Maya will be installed into the Applications/
Alias folder of this volume, but you can specify another 
folder by clicking Choose.

Click Continue. The Easy Install screen appears.

6 If you want to perform a basic (non-customized) installation, 
click Install and proceed to step 8. If you want to choose 
which components of Maya to install, click Customize and 
proceed to the next step.

7 (Optional) If you click Customize, the following dialog box 
appears:

Note If you are not logged in on an account with 
administrator privileges, the installer will ask you to 
type in the name and password of an administrator 
account on the local machine.
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Select which components you want to install. Your choices 
include:

The options for custom installation are:

• Maya_core —You must install this component to use 
Maya on your computer.

• Maya Developer’s Kit—Files and documentation for 
programmers who want to create Maya plug-ins (not 
included in the Easy install).

• Fcheck—A player for Maya movie and image file formats.

• Maya Documentation Server—Software to run the Maya 
online documentation.

• Maya English Documentation — The Maya online 
documentation (in English), which contains reference 
documentation, tutorial files, and multimedia.

8 Click Install.

The Maya software and accompanying utilities are installed 
on your computer. The progress of the installation is indicated 
by the progress bar at the bottom of the installer’s window.
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When the installer finishes a License Maya window appears. 
The software attempts to license you automatically. If this 
step doesn’t succeed, a screen with further licensing options is 
shown.

From this window, you select which method to license your 
Maya software. 

All customers must have a software license. A license is a 
coded record of your software purchase. Which licensing 
method you choose is determined by a number of factors. For 
more information, see Chapter 7, “Licensing Maya”.

9 Select the licensing method that you require and then click 
Next.

Follow the window prompts provided for that particular 
method.

10 When the installer finishes it displays a message indicating 
that the software install is complete.

11 Click Done to complete the installation.

12 Continue with the license setup program after the software 
installation: 

• If you’re an existing Maya customer, your license may 
already be installed for you. 

• If you’re a new Maya customer, start the Product 
Configuration Wizard after installation by launching 
Maya.

• If you’re setting up a license server, see Chapter 7, 
“Licensing Maya” for details of how to set up both servers 
and clients.

For more information, see Chapter 7, “Licensing Maya”.
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Installing the Maya Shader Library

You can either install the Maya Shader Library during the Maya 
software installation or install it later on. The Shader Library 
requires approximately 110MB of disk space.

To install the Maya Shader Library for Mac OS X

1 Insert the Maya software CD into your CD-ROM drive and 
double-click the ShaderLibraryInstaller when the Finder 
window containing the Maya 6.5 installation contents appears.

2 Double-click the installer icon.

The Maya installer launches and the Authenticate screen 
appears prompting you to authenticate as the system 
administrator.

3 Type the system administrator password for your computer in 
the Password or phrase box.

The language selection screen appears.

4 Select your preferred language from the available options in 
the drop-down list and click OK.

5 The installer window appears.
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Click Choose to select the location to install the Shader 
Library. By default, the shader library is installed in the 
following location:

/Users/Shared/Alias/maya/Maya Shader Library

6 Once you have made your option selections click Install.

The Shader Library is installed in the location you specified. 

7 Click Done to exit the installer.

Uninstalling Maya

To uninstall Maya for Mac OS X

1 Navigate to the Maya directory (by default, this is 
Applications/Alias/maya6.5/).

2 Double-click the uninstaller.command icon and follow the 
instructions in the Terminal window that appears.
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Software that can be installed separately

The following additional software is provided on the Maya 6.5 
Mac OS X CD to be installed separately, if necessary.

• QuickTime Components — Allows users who do not have 
Maya to work with IFF files in applications that are 
QuickTime aware.

• Alias License Server — Installs the components necessary for 
a computer running Mac OS X to function as a license server. 
For more information, see Chapter 7, “Licensing Maya”.

Installing Maya 6.5 alongside previous 
versions of Maya

Maya 6.5 and previous versions of Maya can co-exist on the same 
machine. However, be aware of which version of Maya you are 
running. If you run the Render command in a Terminal window, 
you must fully specify the directory path to be sure you are 
getting the version of the Maya renderer you expect.
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for IRIX

Overview of installing Maya for IRIX

This chapter describes how to install Maya for IRIX as well as the 
hardware and system requirements for installing and running 
Maya on an IRIX operating system.

Before you begin

• Your computer system must meet specific requirements in 
order for you to successfully install and run Maya. Alias does 
not support hardware and software configurations that do not 
meet these requirements. Please take a few moments to 
review the following hardware and software requirements 
section. 

• You need access to the root or superuser account and 
password on your computer to install Maya. You do not need 
to be root to launch Maya once it is installed. You should not 
run Maya while logged in as root.

• Make sure you meet the disk space and other requirements by 
reviewing ”System Requirements” on page 44

• You can keep or uninstall previous versions of Maya. 
However, you must uninstall if you are installing the same 
Maya version as the one installed (for example, a pre-release 
copy). See ”Uninstalling Maya” on page 62.

Note The most up-to-date information on specific hardware 
system qualifications for your computer can be found on 
the Alias Web site:

www.alias.com/qual_charts
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The default installation performs the following tasks:

• Creates and installs software in the following directories:

/usr/aw

/usr/aw/maya6.5

This is the base location for all Alias software if it does not 
already exist. Any previous versions of Maya are left 
untouched.

• Creates or updates the symbolic links for the following:

/usr/aw/maya to the actual installation location and some 
files in /usr/sbin to the new Maya software.

• Updates Alias common software (/usr/aw/COM) to work with 
Maya. This software contains the shared libraries and license-
related programs used by all Alias software.

• Creates an Alias software page in the Icon catalog if it does 
not already exist.

• Adds Alias file types to the file database (/etc/magic).

System Requirements

Alias certifies certain computer system configurations as meeting 
the requirements to work with the Maya software. To determine 
whether your particular system meets these requirements, please 
check the qualification charts for the latest information at 
www.alias.com/qual_charts.

The system requirements are categorized as follows:

• Hardware and memory requirements—page 45

• Operating system requirements—page 45

• Disk space requirements—page 45
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Examining system requirements

• You can obtain information about your computer’s processor 
and memory by typing the following command in a shell 
window:

hinv

• You can obtain information about the specific version of IRIX 
operating system on your computer by typing the following 
command in a shell window:

uname -R

Hardware and memory requirements

To install and run Maya, your workstation must have:

• A system qualified to run Maya. Refer to the qualification 
charts at:

www.alias.com/qual_charts

• 512MB or more available memory

• Keyboard

• Three-button mouse with mouse driver software

• Access to a CD-ROM drive

Operating system requirements

• Maya 6.5 requires IRIX 6.5.15 or higher (depending on the 
system configuration). For the qualified version of IRIX 6.5. 
Refer to the qualification charts at:

www.alias.com/qual_charts

Disk space requirements

The following are approximate sizes for the various Maya 
installation. These are default, minimal sizes; you’ll need more 
space to install optional selections. 
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• Maya Complete: 350MB (including 74MB for Maya online 
documentation)

• Maya Unlimited: additional 22MB (372MB total)

• Maya Shader Library: additional 110MB

Installing Maya

This section describes how to install Maya, as well as the Shader 
Library. You can choose from the following methods of 
installation:

• ”Installing Maya using Software Manager” on page 46

• ”Installing Maya using the inst utility” on page 51

Other optional methods for the installation of Maya, such as batch 
installation, are covered in ”Advanced installation procedures” on 
page 54.

Installing Maya using Software Manager

To install Maya using Software Manager

1 Log in to the target machine as root. 

Note To find out the disk space for custom installations, view 
the information listed by Software Manager when you 
click Customize Installation. 

Note It is possible to install Maya remotely across a network 
using a remote shell window. For this reason, the 
instructions refer to the target machine as the machine 
in which Maya is currently being installed.
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If you don’t have root user privileges, see your system 
administrator.

2 Insert the Maya software CD into the target machine or a 
remote machine with a CD-ROM drive. 

3 Check for the following CD-ROM icon on your desktop, 
indicating that your CD-ROM is mounted. 

If you do not have the CD-ROM icon, check that the CD-ROM 
drive is mounted by typing ls /CDROM. This command lists 
the CD-ROM contents. 

If the CD-ROM is not mounted, see ”Mounting a CD-ROM 
drive” on page 57.

4 On the target machine, start Software Manager by doing one 
of the following:

• Type the following in a shell: swmgr <enter>.

• Double-click the CD-ROM icon on your desktop. In this 
case, skip to step 7.

5 Type the path to the CD-ROM at the top of the Software 
Manager window, for example:

 /CDROM/dist <enter>

Note Remember to log out of root when you want to run 
Maya. Alias does not recommend running Maya as a 
root user.
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If you are using a remote CD-ROM drive and your network is 
set up to use NFS with auto-mount, enter the path to the 
remote CD-ROM. For example:

/remote/host/CDROM/dist

where remote is the auto-mount point and host is the remote 
machine name. 

For other methods of accessing a remote CD-ROM drive, see 
”Accessing a remote CD-ROM” on page 59.

6 Click Lookup. 

7 Click Execute after reading the installation instructions. 

Note dist must be added to the path or this step won’t work.
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8 When the Software Manager window reappears, click the 
Start button. You can also click Customize Installation to turn 
off or on the items you want to install. At a minimum, you 
must install Alias Common Utilities and Maya 6.5, Base 
Software. These apply even if you are only batch rendering on 
this machine. However, if this machine is only serving licenses 
and not running Maya itself, make sure that Alias License 

Note If an Alias Installation Error/IRIX Software Manager 
Conflicts window displays, you may need to either 
install or remove specific software from your system to 
correct the issue. Follow the instructions in the window 
before proceeding with the installation. For more 
information see ”Troubleshooting” on page 127.
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Server Software is checked to be installed in the Alias 
Common Utilities and ensure that your license tools are 
updated. (Maya 6.5 requires license tools 3.4.10 including 
FLEXlm 9.0 Server Software.)

The Maya Unlimited 6.5 software is selected by default. Turn 
it off if you are installing Maya Complete and you want to 
save space.

9 Look for the following dialog box to indicate that the software 
installed successfully.

Note On some machines, the Start button is disabled when 
you choose Default Installation. In this case, you must 
click Customize Installation and then click Start. 
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10 Select Exit and click OK.

Before you can run your copy of Maya, it must first be licensed for 
use on your computer, see ”Licensing Maya” on page 85.

If you want to install the shader library, see ”Installing the Maya 
Shader Library” on page 60.

Installing Maya using the inst utility

As an alternative to Software Manager, you can install Maya 
using the inst utility in a UNIX shell. 

Prerequisite steps

• Stop Maya and any license server processes, if running.

• Make sure you meet the ”System Requirements” on page 44.

To install using inst interactively

1 Log into the target machine as root.

2 Insert the Maya 6.5 Software CD into the target machine or a 
remote machine with a CD-ROM drive. 

3 Check for the following CD-ROM icon on your desktop, 
indicating that your CD-ROM is mounted. 
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If you do not have this icon, check that the CD-ROM drive is 
mounted by typing ls /CDROM. This should list its contents. 

If the CD-ROM is not mounted, see ”Mounting a CD-ROM 
drive” on page 57.

4 On the target machine, enter the following command in a 
UNIX shell:

/usr/sbin/inst

5 At the inst> prompt, use the from command to specify the 
distribution area (for example: from /CDROM/dist).

If you are using a remote CD-ROM drive and your network is 
set up to use NFS with auto-mount, enter the path to the 
remote CD-ROM. For example:

/remote/host/CDROM/dist

where remote is the auto-mount point and host is the remote 
machine name. 

For other methods of accessing a remote CD-ROM drive, see 
”Accessing a remote CD-ROM” on page 59.

6 After the README information appears, select option 1, Run 
the installation startup script now, to continue with the Maya 
installation. 

7 Do one of the following:

• To install Maya default subsystems, enter go.

• To choose non-default selections, enter step, enter i on 
each line of the subsystems you want to install, then enter 
go. 
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At a minimum, you must install Alias Common Software, 
Common Desktop environment, and Maya Base Software. 
These apply even if you are only batch rendering on this 
machine. However, if this machine is only serving licenses 
and not running Maya itself, you can install just the Common 
Software and Common Desktop environment. As well, ensure 
that your license tools are updated. (Maya 6.5 requires license 
tools 3.4.10 including FLEXlm 9.0 Server Software.)

Maya Unlimited 6.5 software is selected by default. Turn it off 
if you are installing Maya Complete and you want to save 
space.

Using inst without prompts 

Alias recommends using the software manager utility for the 
installation of Maya. You can alternatively install Maya using the 
inst utility. If you are an advanced user, familiar with inst, you 
can run it without prompts, especially if you want to run it as part 
of a batch script. However, it requires that all prerequisites have 
been installed and that there is sufficient disk space. 

See ”Installing Maya on many machines at once” on page 55 for 
information on using inst in a batch script.

To install using inst without prompts

1 Log in to the target machine as root.

2 Load the CD on the target machine or a remote machine with 
a CD-ROM drive.

3 From a UNIX shell, type the following:

/usr/sbin/inst -a -f dist -V startup_script:execute

where dist is the location of the images, such as /CDROM/dist 
or a remote machine path. 

4 Once the Maya software is successfully installed, you can 
proceed to Chapter 7, “Licensing Maya.” 
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Advanced installation procedures

Complete the following procedures if you want to install Maya on 
a different file system, in a client/server configuration, or on 
multiple systems at one time.

Installing on file systems other than /usr

By default, Maya is installed in the /usr partition. If you want to 
install Maya on a different file system (due to lack of sufficient 
disk space), create a symbolic link from /usr/aw/maya6.5 to that 
file system. For example, if your file system was called 
/freespace, you would enter the following commands before 
installing Maya:

su root

mkdir -p /freespace/aw/maya6.5 

mkdir -p /usr/aw 

ln -s /freespace/aw/maya6.5 /usr/aw

When you install using this method, Software Manager may 
report there is insufficient disk space even though you know there 
is sufficient space on /freespace. If this happens, enter the 
following command in the Software Manager’s Command 
Window:

set override_space_check true 

This lets you install Maya on the other file system even though 
/usr is full.

Performing a client/server installation

You can install Maya in a client/server configuration. In this 
configuration, the full Maya software is installed on a server 
whose file system is NFS-mounted on each of the clients. The 
clients then have a minimal set of software installed locally for 
desktop and security purposes.
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To install Maya in a client/server installation

1 Install all Maya software on the server machine.

2 Install the Maya client software on each of the clients.

The selection file, maya6_x_client.sel, specifies what 
software should be installed on each client. This file is on the 
Maya CD under the dist directory. 

3 Mount the Maya software directory /usr/aw/maya6.5 from 
the server to each client /usr/aw/maya6.5 directory. 

4 If you have SuperConductors installed (either from the 
Conductors CD or downloaded from the Alias Web site), also 
mount the /usr/aw/userconfig directory on each client. 

Installing Maya on many machines at once

In order to install several machines simultaneously, you must 
create a batch script that executes the inst utility without prompts. 
Before this type of installation, make sure all prerequisite software 
and patches are installed, that there is enough disk space for the 
installation, and that there are no installation conflicts.

The key command that runs inst without prompts is: 

/usr/sbin/inst -a -f dist -V startup_script:execute

where dist is the location of the dist directory (for example: 
/CDROM/dist).

Note We do not recommend a client/server configuration 
because it has a negative impact on Maya’s 
performance. This is particularly a problem on slow 
networks. If you do choose to install a client/server 
configuration, be sure to install the IRIX prerequisite 
software and patch sets on each client. 
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To create and run a batch installation script

1 Generate a file that contains a list of host names you want to 
install Maya on, one host name per line.

2 Ensure that the Maya distribution CD is accessible from each 
of the clients. NFS is the preferred method for doing this, but 
is not absolutely necessary.

3 Make sure that all the machines have the necessary IRIX 
prerequisites and patches installed. 

If inst detects any missing prerequisites, the program will stop 
and your script will break.

4 Create a script that logs into each host and executes this 
command:

/usr/sbin/inst -a -f dist -F dist/maya6_x.sel -V 
startup_script:execute

For example, if the file from step 1 was named hostlist and 
the distribution CD was located at master:/CDROM/dist, you 
could use this sh script:

for i in `cat hostlist`

do

echo "Installing on host $i"

rsh $i "/usr/sbin/inst -a -f master:/CDROM/dist \

-F master:/CDROM/dist/maya6_x.sel -V 

startup_script:execute

done

(This script uses Bourne/Korn shell syntax. Make the 
appropriate changes if you use the C shell.)

Note This example script installs the maya6_x.sel (normal or 
server) selection file. You can substitute 
maya6_x_client.sel to install client-only software. 
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To install Maya client software on multiple machines 
in batch mode

1 Substitute the following selection file name in the -F 
argument of the batch script:

maya6_x_client.sel

2 You must also do the following:

• Use -V startup_script:ignore instead of 
-V startup_script:execute

• Specify an exact /CDROM/awdist6.X directory instead of 
/CDROM/dist

The following script shows an example for installing client-
only software:

for i in `cat hostlist`

do

echo "Installing on host $i"

rsh $i "/usr/sbin/inst -a -f 
master:/CDROM/awdist6.5 \
-F master:/CDROM/awdist6.5/maya6_x_client.sel \ 
-V startup_script:ignore

done

Mounting a CD-ROM drive

If you experience problems because your CD-ROM drive is not 
mounted, follow these steps, for either a local or remote drive.

To mount a local CD-ROM drive

1 Find the controller number and unit number for the drive by 
typing:

hinv | grep CD

The output of this command will be similar to:
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CDROM: unit 4 on SCSI controller 0

In this example, the controller number is 0 and the unit 
number is 4.

2 Use the controller number and unit number to form the device 
name for the CD-ROM drive. The device name is in the 
format:

/dev/scsi/sc#d#l0

where the number following sc is the controller number, the 
number that follows the d is the unit number, and l0 is 
spelled with lowercase l and zero. For the previous example, 
the device name would be /dev/dsk/sc0d4l0.

3 If a CD-ROM directory does not exist, create it by typing:

mkdir /CDROM

4 Mount the CD-ROM drive as a directory by typing:

/etc/mount -t iso9660 /dev/scsi/sc#d#l0 /CDROM

where /dev/scsi/sc#d#l0 is the device name from step 2 
and /CDROM is the directory you are mounting the CD-ROM 
drive to.

To mount a remote CD-ROM drive across a network 
with NFS

These instructions assume you have NFS on both workstations. 

1 On the remote machine, make sure the drive is mounted. 

2 On the remote machine, add the file system to the exports list 
to allow your target machines to use the CD-ROM drive. 

Using a text editor, add /CDROM to the /etc/exports file. 

3 On the remote machine, type /usr/etc/exportfs -a to 
allow other machines in the network to access the file system. 
This command requires NFS.
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4 On the target machine, if a CD-ROM directory does not exist, 
create it by typing: 

mkdir /cdrom

In this example, we use /cdrom. You can use another name for 
the directory if you prefer.

5 On the target machine, mount the CD-ROM drive as a 
directory. Type:

/etc/mount hostname:/CDROM /cdrom

where hostname is the name of the machine that has the CD-
ROM drive.

Accessing a remote CD-ROM

There are several ways to access a remote CD-ROM drive. We 
recommend having the CD-ROM drive auto-mounted. If you do 
not have this capability, here are some other typical methods.

Local mount point using NFS

If you followed the instructions ”To mount a remote CD-ROM 
drive across a network with NFS” on page 58, you specify that 
mount point during the installation. We recommend using 
lowercase /cdrom as the local mount directory, because uppercase 
/CDROM can cause installation problems. 

Note We use /cdrom (lowercase) as the local mount directory 
instead of /CDROM (uppercase). Using uppercase /CDROM 
as the local mount directory of a remote CD-ROM drive 
can cause installation problems. 
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Trusted user account

If you do not have NFS, you can still access a remote drive during 
the installation by specifying a trusted account on the remote 
machine. For example, in the Software Manager or inst from 
command, type: 

root@host:/CDROM/dist

where host is the name of a remote machine with trusted-root 
access. If the remote computer does not have trusted-root access, 
you can use an account that does not have a password. For 
example:

guest@host:/CDROM/dist

Installing the Maya Shader Library

After installing Maya, you can install the Maya Shader Library, 
which is a collection of Maya scene files consisting of over 60 
shading networks, including materials and file textures. To use 
the Shader Library, you can:

• run it from your local machine

• run it from the server

• run it from the CD-ROM

In order to run it from your local machine, you have to copy the 
entire shaderLibrary directory and its contents to your computer. 
For example, you can copy it to /usr/aw/shaderLibrary. If 
multiple users will be accessing this library, put it in a location in 
which all of the users have read access. 

We recommend that you update each user’s Maya environment 
file or .cshrc file so that Maya knows where you’ve stored the 
Shader Library. You should also set up a Shader Library tab in 
Hypershade.
Installation and Licensing Guide 

60



4 | Installing Maya for IRIX

 > Installing the Maya Shader Library
To install the Maya Shader Library

1 Insert the Maya 6.5 Installation CD.

2 Start an IRIX shell.

3 Log in as root.

4 Type the following:

cd /CDROM

cp -pr shaderLibrary /usr/aw

To update the Maya.env file or the .cshrc file

In the user’s Maya.env or .cshrc file, set the following 
environment variable (for example):

setenv MAYA_SHADER_LIBRARY_PATH /usr/aw/shaderLibrary

To set up a Shader Library tab in Hypershade

1 Start Maya.

2 In Hypershade, select Tabs > Create New Tab to open the 
Create New Tab window. 

3 Type Shader Library in the New Tab Name text box. 

4 Set the Initial Placement to Bottom. 

5 Set the Tab Type to Disk. 

6 Click the Root Directory folder button to browse to the path to 
which you copied the shader library directory and click OK. 

Note Alternatively, you can access the Shader Library from 
the CD-ROM or copy the shaderLibrary directory to 
another location in your own home directory and set the 
following variables accordingly.

Note This must be done for each user.
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7 Click Create to see the new tab in the Hypershade panel. 

Uninstalling Maya

To ensure a clean installation, uninstall any existing copy of 
Maya 6.5 on your computer before reinstalling Maya 6.5.

To uninstall Maya for IRIX using software manager

1 Log into the target machine as root.

2 Start software manager by typing the following command in a 
shell window:

swmgr <enter>

3 Click Manage Installed Software.

A list of installed software products appears.

4 From the list, select the Maya software products that you wish 
to uninstall.

5 Click Start.

The software products will be uninstalled from your 
computer.
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Overview of installing Maya for Linux

This chapter describes how to install Maya for Linux as well as the 
hardware and system requirements for operating Maya on an 
Linux operating system.

Before you begin

• Your computer system must meet specific requirements in 
order for you to successfully install and run Maya. Alias does 
not support hardware and software configurations that do not 
meet these requirements. Please take a few moments to 
review the following hardware and software requirements 
section. 

• You will need access to the root or superuser account and 
password on your computer to install Maya. You do not need 
to be root to launch Maya once it is installed. You should not 
run Maya while logged in as root.

• Make sure you meet the disk space and other requirements by 
reviewing ”System requirements” on page 64.

• You can keep or uninstall previous versions of Maya. 
However, you must uninstall if you are installing the same 
Maya version as the one installed (for example, a pre-release 

Note The most up-to-date information on specific hardware 
system qualifications for your computer can be found on 
the Alias Web site:

www.alias.com/qual_charts
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copy). You must also uninstall the AWCommon and 
AWCommonserver software before installing. See 
”Uninstalling Maya” on page 72.

The default software installation performs the following tasks:

• Creates and installs software in the following directories:

/usr/aw

/usr/aw/maya6.5

This is the base location for all Alias software if it does not 
already exist. Any previous versions of Maya are left 
untouched.

• Creates or updates the symbolic links for the following:

/usr/aw/maya to the actual installation location. 

Some files in /usr/local/bin to the new Maya software.

System requirements

Alias certifies certain computer system configurations as meeting 
the requirements to work with the Maya software. To determine 
whether your particular system meets these requirements, please 
check the qualification charts for the latest information at 
www.alias.com/qual_charts.

The system requirements are categorized as follows:

• Hardware and memory requirements—page 65

• Operating system requirements—page 65

Note If you are installing Maya on a remote machine, make 
sure the DISPLAY environment variable is pointing to 
your local machine so that the licensing GUI is 
displayed on your local machine to complete the 
installation.
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• Graphics requirements—page 65

• Disk space requirements—page 66

• Other software—page 66

• Optional hardware—page 67

Examining system capabilities

• You can obtain information about your computer’s processor 
and memory by accessing the KControl (KDE Control Panel) 
or typing kcontrol in a shell window. 

Hardware and memory requirements

To install and run Maya, your workstation must have:

• Pentium II or higher processor, 300 Mhz or greater; Pentium 4 
or AMD Athlon recommended

• 512MB or more available memory

• Keyboard

• Three-button mouse with mouse driver software

• a CD-ROM drive

• a network card

Operating system requirements

Maya 6.5 has been qualified on Red Hat Linux 9.0 and Enterprise 
Linux WS 3.0. Please check at www.alias.com/qual_charts.

Graphics requirements

• A graphics card qualified to run Maya. Please refer to:

www.alias.com/qual_charts
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Disk space requirements

• Minimum: 250MB (without documentation package) 

• Standard: 360MB (with documentation package) 

Other software

The following software must be installed on your workstation:

OpenMotif run-time environment 

With Maya 6.5 the required library libxm.so.3 is automatically 
installed in /usr/aw/maya6.5/lib.

FAM run-time environment

The File Access Monitor (FAM) software allows Maya to monitor 
file changes in the Expression editor. FAM may already be 
included, so you should check first to see if the files are already 
installed. Enter: 

rpm -qa | grep fam

X-Server/OpenGL Visuals requirements

Maya expects to obtain specific visuals for use with OpenGL. The 
preferred visual configuration is:

• Both single and double buffered RGBA 8/8/8/8, with 24 bit 
depth buffers. 

Note Many graphics card manufacturers document the setup 
of their graphics card for use with Maya. Refer to the 
instructions that came with your particular graphics 
card.
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• To use the Hardware Render Buffer window, adding Alpha 
and Accumulator buffers are also required.

If Maya can not obtain the visuals it requests, it usually outputs 
what was not found and continues if possible. Some aspects of 
Maya may not work correctly if the expected visuals are not 
available. Use the program glxinfo to list currently available 
visuals.

Please check you are using qualified video cards and drivers at:

www.alias.com/qual_charts

Optional hardware

Wacom tablet—The Wacom tablet works the same as with other 
programs. Using the pen and tablet overrides mouse operation. 
When the pen is out of contact with the tablet, the mouse becomes 
operational. Check the Wacom Web site for details on support of 
this device with a Linux operating system (www.wacom.com).

Installing Maya

This section describes how to install Maya for Linux. When the 
installation is complete, you must license Maya. You must install 
Maya licenses if you are:

• Installing Maya for the first time.

• Adding additional licenses to a floating-type license.

• Changing the machine on which Maya is installed.

For information on upgrading to a higher version of Maya. See 
Chapter 7, “Licensing Maya” for details. If you have problems 
installing, see Chapter 8, “Troubleshooting.”
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Installing Maya using the rpm utility 

This section describes how to install Maya for Linux using the rpm 
command-line utility. With the rpm command you can use either 
the -i flag or the -ivh flag to install the programs. The -ivh flag 
provides you with more information during the installation.

To install using rpm

1 Log in as root.

2 Insert the Maya CD into a CD-ROM drive. 

3 Mount the CD-ROM drive. For example, type:

mount -r /dev/cdrom /mnt/cdrom

4 Change to the CD-ROM directory where the Maya for Linux 
is installed. For example, type:

cd /mnt/cdrom/LINUX

5 Use the ls command to list the packages on the CD. 

Note If you have previously installed a version of Maya 6.5 
for Linux, uninstall that version before installing this 
newest version. See ”Uninstalling Maya” on page 72.

Package Name (# is the 
package number)

Description When Required

AWCommon-6.3-1.i686.rpm Licensing 
software

Always

AWCommon-server-6.3-1.i686.rpm Licensing 
Server 
software

For serving 
floating licenses

Maya6_5-6.5-#.i686.rpm Maya for Linux Always
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6 To install the required base software, enter the following 
command

rpm -ivh AWCommon-6.3-1.i686.rpm Maya6_5-6.5-#.i686.rpm

where # is the specific package number. For example, if the 
package number is 93 for Maya:

rpm -ivh AWCommon-6.3-1.i686.rpm Maya6_5-6.5-93.i686.rpm

Maya 6.5 adds the required libxm.so.3 library to the Maya 
lib directory as part of its standard install, so installing the 
openMotif runtime rpm is not required.

7 Verify that OpenGL is installed. Look for a file named 
libGL.so in the /usr/lib or /usr/X11R6/lib directory.

8 To install the documentation, type the following:

rpm -ivh Maya6_5-docs-6.5-#.i686.rpm

where # is the specific package number.

9 You should see the software files installed in the following 
directory:

Maya6_5-docs-6.5-#.i686.rpm Maya 6.5 
documentation

Optional

Package Name (# is the 
package number)

Description When Required

Note If you have a previously installed version of 
AWCommon and Maya for Linux, uninstall that version 
before installing this newest version. To verify what 
version you have, type:

rpm -qa | egrep 'AWCommon|Maya'

 See “Uninstalling Maya” on page 72.
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/usr/aw/maya6.5

Once the Maya software is successfully installed, unmount 
and eject the CD and store it in a safe place. Proceed to 
Chapter 7, “Licensing Maya.”

Installing Maya on file systems other than /usr

By default, Maya is installed in the /usr partition. If you want to 
install Maya on a different file system (due to lack of space), create 
a symbolic link from /usr/aw/maya6.5 to that file system. 

For example, if you are installing Maya on a file system called 
/freespace, type the following commands:

su root

ln -s /freespace/aw/maya6.5 /usr/aw

Installing the Maya Shader Library

After installing Maya, you can install the Maya Shader Library, 
which is a collection of Maya scene files consisting of over 60 
shading networks, including materials and file textures. To use 
the Shader Library, you can:

• run it from your local machine

• run it from the server

• run it from the CD-ROM

Note In order to use Maya, you may need to perform 
additional setup procedures. See the ”Additional Linux 
Notes” on page 73 for additional information.
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In order to run it from your local machine, you have to copy the 
entire shader library directory and its contents to your computer. 
For example, you can copy it to /usr/aw/shaderLibrary. If 
multiple users will be accessing this library, put it in a location in 
which all of the users have read access. 

We recommend that you update each user’s Maya environment 
file or .cshrc file so that Maya knows where you’ve stored the 
Shader Library. You should also set up a Shader Library tab in 
Hypershade.

To install the Maya Shader Library

1 Insert the Maya 6.5 software CD.

2 Start a Linux shell.

3 Log in as root.

4 Type the following:

cd /CDROM/LINUX

cp -pr shaderLibrary /usr/aw

To update the Maya.env file or the .cshrc file

In the user’s Maya.env or .cshrc file set the following 
environment variable (for example): 

     setenv MAYA_SHADER_LIBRARY_PATH /usr/aw/shaderLibrary

Note Alternatively, you can access the Shader Library from 
the CD-ROM or copy the shaderLibrary directory to 
another location in your own home directory and set the 
following variables accordingly.
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To set up a Shader Library tab in Hypershade

1 Launch Maya.

2 In Hypershade, select Tabs > Create New Tab to open the 
Create New Tab window. 

3 Type Shader Library in the New Tab Name text box. 

4 Set the Initial Placement to Bottom. 

5 Set the Tab Type to Disk. 

6 Click the Root Directory folder button to browse to the path to 
which you copied the shaderLibrary directory and click OK. 

7 Click Create to see the new tab in the Hypershade panel. 

Uninstalling Maya

To uninstall Maya for Linux you can use the rpm utility.

To uninstall Maya using rpm

1 Log in as root.

2 List the installed package names by entering:

rpm -qa | egrep 'AWCommon|Maya'

3 Identify the package name you want to uninstall. 

For example, you may see the following package:

Maya-6_5-#

You may also see the AWCommon packages, which are used 
for licensing:

AWCommon-6.3-#
AWCommon-server-6.3-#

Note Uninstalling the AWCommon software does not affect 
any license files in the license directory (/var/flexlm).
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4 Uninstall all listed packages using the following command:

rpm -e Package

where Package is the name obtained in the previous step. 

Additional Linux Notes

These additional Linux user notes provide special information for 
configuring Maya to run on Linux, describe differences between 
Maya for Linux and other versions of Maya, that are specific to 
using Maya on the Linux operating system. For complete 
information on limitations and possible work a rounds, also refer 
to the Maya 6.5 Release Notes.

Compiling plug-ins and standalone programs

To compile plug-ins and standalone applications for Maya 6.5 on 
Linux, use the released gcc 3.3.4 compiler. Maya has been 
compiled with this compiler under RedHat 9.0. 

Plug-ins built with any other compiler will not work because the 
C++ ABI (Application Binary Interface) must match between 
Maya and plug-ins.

In order to build plug-ins you do the following:

1 Download the released gcc 3.3.4 compiler from the gcc web or 
mirror site: gcc.gnu.org/releases.html.

2 Compile and install the compiler using the gcc instructions.

The compile options that were used with Maya are:

gcc334 -v
Reading specs from /opt/gcc334/lib/gcc-lib/i686-pc-linux-gnu/3.3.4/specs
Configured with: ../gcc-3.3.4/configure --prefix=/opt/gcc334 --program-
suffix=334 --enable-shared --enable-threads=posix --disable-checking 
--with-system-zlib --disable-libunwind-exceptions 
--enable-__cxa_atexit
Thread model: posix
gcc version 3.3.4
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3 Modify the makefiles to use the proper compiler.

In the makefile modify the C++ line to use the proper 
compiler. How this occurs depends on how the options were 
given when compiling the compiler. In the case of Maya, the 
compiler used was named g++334.

Installation notes

Because Maya is compiled under Red Hat 9.0, it is necessary to 
include some libraries that are not available in standard 9.0 
distributions. These libraries and symbolic links are installed in 
/usr/aw/maya6.5/lib and should not interfere with the normal 
operation of your Linux system:

• libstdc++.so.5.0.6

• libstdc++.so.5 -> libstdc++.so.5.0.6

• libstdc++.so -> libstdc++.so.5.0.6

• libgcc_s.so.1

• libgcc_s.so -> libgcc_s.so.1

Differences in operation

When installed on a Linux system, Maya works in much the same 
way as when installed on Windows or IRIX. One difference is that 
when you put a menu item or option on the shelf, you press 
Shift+Alt right mouse button (instead of Shift+Ctrl+Alt on IRIX).

Using the MayaScheme file to set fonts, font sizes, 
and colors

Fonts, font sizes, and colors can be configured using the 
MayaScheme file. This file lets you specify X Resources that Maya 
uses for configurable text. The default file is found in /usr/aw/
maya6.5/app-defaults/MayaScheme. Copy this file to your home 
directory’s $HOME/app-defaults so that it can be edited.

Refer to the Maya 6.5 Release Notes for any known limitations.
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Unsupported Maya features

Some of the features in our IRIX and Windows versions are not 
currently supported. These include output to AVI or SGI movie 
formats. Please refer to the Maya 6.5 Release Notes for more 
information.

Linux desktop configuration

To use Maya on Linux, certain default keyboard and mouse 
bindings must be changed from the factory settings. These default 
bindings prevent commands from being received by Maya, such 
as the ones that let you tumble or pan a view in a panel. 

Different Linux window managers have different key bindings 
and different procedures for setting them. Linux systems are 
highly customizable, many combinations of Linux system 
components are possible—more than can be described (or tested) 
by Alias. 

The following instructions give the procedures necessary for 
changing the most common configurations.

Changing Window Manager keyboard bindings

The following lists procedures to change Window manager 
factory settings for KDE and Gnome.

KDE and Gnome desktop configuration

For Maya to work properly with KDE and Gnome, some 
modifications should be made to the mouse control. The default 
bindings of the Alt key and mouse buttons do not work well with 
Maya. We recommend turning off the Alt+mouse buttons. Since 
Maya uses the Alt+mouse buttons for viewport tumbling, you 
need to ensure the bindings don’t conflict.
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Different versions of KDE and Gnome may have different 
methods of selecting the key bindings. See the KDE and Gnome 
documentation for instructions if the following instructions don’t 
work for your window manager. 

KDE under Red Hat 9

1 Open the KDE Control Center.

2 Select Desktop and then select Window Behavior.

3 Open the Actions tab.

4 In the Inner Window, Titlebar & Frame section, for modifier 
key Alt, set all mouse action combinations to Nothing. 

5 Click Apply and close the Control Center.

Gnome under Red Hat 9

1 Open the Gnome Panel.

2 Select Preference and then select Windows.

Set to 
‘Nothing’.

Alt
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3 In the Window Preferences dialog box, set the “To move a 
window...” key to Super.

(Setting either Control or Alt here may cause problems when 
using Maya.)

4 Click Close.
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6 Installing mental 
ray (satellite)

Overview

Mental ray for Maya now supports a new form of network 
rendering: mental ray satellite rendering. The new network 
rendering capability, based on mental ray satellite technology, 
allows you to install a version of mental ray (satellite) on any 
networked computer. This special version of mental ray resides 
on that machine and waits for rendering tasks from Maya. It 
supplements the mental ray rendering capabilities in Maya with 
additional rendering power provided by the networked 
computers’ CPUs. 

The rendering process is typically initiated from the master 
machine (the machine running Maya or where the command-line 
render starts from). The slave machines (satellite rendering 
computers) process rendering tasks they receive over the network 
from the master and send back results. The master machine 
handles task distribution, load balancing, and the collection of 
received rendering tasks which make up the rendered image. 

For more information about mental ray satellite, see “Rendering 
with mental ray for Maya and mental ray satellite” in the What’s 
New for Maya 6.5 guide.

Slave machine installation

Note mental ray satellite is not available for IRIX.
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The special version of mental ray standalone with satellite 
rendering technology must be installed on all slave machines. The 
satellite-enabled versions of mental ray for Windows, Mac OS X, 
and Linux are included with this release of Maya on a separate 
CD.

(Windows) To install mental ray standalone with 
satellite licensing

1 On each slave machine, begin the installation process by 
inserting the mental ray satellite CD and double-clicking the 
mental ray standalone installer.

• (Windows) Mental_Ray_Satellite_3.4-win32.exe

The installer appears. 

2 Follow the installation steps. 

During the installation, you can click Custom to change the 
installation directory. The default installation directory is 
C:\Program Files\Alias\mentalraysatellite3.4\.

(Mac OS X) To install mental ray standalone with 
satellite licensing 

1 On each slave machine, begin the installation process by 
inserting the mental ray satellite CD and double-clicking the 
mental ray standalone installer.

• (Mac OS X) mentalraysatellite34.dmg

The disk image mounts.

2 Double-click install_mentalray_satellite.

3 Follow the installation steps. 

During the installation, you can change the installation 
directory. The default installation directory is 
/Applications/Alias/mentalraysat34.
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(Linux) To install mental ray standalone with satellite 
licensing using rpm

1 Log in as root.

2 On each slave machine, begin the installation process by 
inserting the mental ray satellite CD.

3 Mount the CD-ROM drive. For example, type:

mount -r /dev/cdrom /mnt/cdrom

4 Enter the following command (where # is the specific package 
number):

rpm -ivh mental_ray_satellite3_4-3.4-#.i686.rpm 

Slave machine additional setup

Once this version of mental ray is installed and running, it waits 
for rendering tasks from mental ray for Maya on the master 
machine. The satellite-enabled version of mental ray does not 
require its own licensing; it is activated through Maya’s licensing.

On the slave machine, the Ray Sat server must be running. 

To verify that Ray Sat server is running (Windows)

1 Open a Windows command prompt.

2 Navigate to the /bin directory of the mental ray satellite 
standalone. By default this is C:\Program 
Files\Alias\mentalraysatellite3.4\bin\.

3 Type the following:

raysatserver /query

A message should be returned saying Ray Sat Server service is 
running.
Installation and Licensing Guide

81



6 | Installing mental ray (satellite) 
 > Slave machine port setup
If you do not get this message, make sure that Ray Sat Server 
has been installed as a service, and start it from the Services 
Control Panel (Settings > Control Panel > Administrative 
Options > Services) or type the following:

raysatserver /start

Slave machine port setup

On the slave machine, port number 7103 is set by default. You 
must edit the services file to change the port number that mental 
ray satellite uses to a value other than 7103.

To change the port number

1 Edit the services file with a text editor.

The services file is located at:

• (Windows 2000) 
C:\WINNT\system32\drivers\etc\services 

• (Windows XP) 
C:\Windows\system32\drivers\etc\services 

• (IRIX, Linux, and Mac OS X) /etc/services 

2 Change number in the following line (here, 7103) to the 
desired port number:

mi-raysat   7103/tcp

Licensing of satellite rendering

For more details about licensing of Maya, see the Licensing chapter 
of this guide. 
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Your version of Maya determines how many networked CPUs 
running satellite-enabled mental ray standalone can participate in 
a render:

• Maya Complete – 2 additional networked CPUs

• Maya Unlimited – 8 additional networked CPUs

For node-locked licenses, the use of mental ray for Maya with 
satellite can only be initiated from the specified host for which 
your received your Maya key. The workstation can distribute 
mental ray for Maya rendering to either two or eight slave CPUs 
depending on your license.

For floating licenses, use of the new functionality is slightly more 
flexible. 

Depending on the type of a Maya license you purchased, you 
additionally have either a mental ray for Maya Complete or 
mental ray for Maya Unlimited line item in your license. For 
floating license setups, the license running Maya and the license 
running mental ray for Maya can be logged out separately 
allowing certain rendering tasks to be initiated remotely.

There are two possible cases when using mental ray for Maya 
with floating licenses:

• (Interactive) With Maya running interactively on a 
workstation, initiate a mental ray for Maya render (either a 
single frame in the Render View, Batch render or command 
line render) on the workstation. The floating mental ray for 
Maya portion of your license is logged out. This allows the 
mental ray satellite slaves indicated in your rayhost file to 
participate in the render. The type of license you purchased 
controls whether you can use up to 2 or 8 mental ray 
standalone slave CPUs on other computers.

• (Offline) If you launch a command line mental ray for Maya 
render from any computer that is not a Maya workstation 
(and the interactive version of Maya is not running), the 
Installation and Licensing Guide

83



6 | Installing mental ray (satellite) 
 > Licensing of satellite rendering
mental ray for Maya license which allows the largest number 
of slaves (that is, Maya Unlimited) in your license server will 
be checked out first. The computer you launched the 
command from then becomes the master machine for mental 
ray for Maya satellite rendering. 

This licensing behavior can be overridden using the -lic mc 
flag with the Render -r mr command; that is, Render -r mr 
-lic mc attempts to check the mental ray for Maya Complete 
line item within the license first, and then the Unlimited line 
item within the license if a Complete line item is not available. 

For more details on mental ray rendering, see the Rendering 
sections of the Maya Help, as well as the mental ray reference 
included with the Maya Help.

Note If you have launched Maya but have not yet rendered 
with mental ray for Maya since the start of your 
interactive session, no mental ray for Maya line item 
from your floating license is checked out. You may 
therefore start a command line mental ray for Maya 
render from another host. This will check out the mental 
ray for Maya portion of your license, making it 
unavailable for any other workstation. 
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Overview of licensing

All customers must have a software license to run Maya. A license 
is a coded record of your software purchase. The license resides in 
a license file on your machine or a license server machine. 
Whenever a Maya session is launched, the license management 
software, FLEXlm, searches the license file to check out a license 
for that session.

If you are an existing Alias customer, your license may already be 
installed for you when you install Maya, using the Prekey file on 
the Maya software CD. A message during the software 
installation tells you if the license wasn’t installed. For more 
information, see ”Prekey” on page 88.

If you are an existing Alias customer and your licenses were not 
automatically installed during the installation process, you can 
obtain and install your licenses from the Webkey file on the Alias 
Web site. For more information, see ”Webkey” on page 88.

If you are a new customer, or you’re an existing customer and 
your licenses are still not installed, follow the instructions in this 
chapter to obtain and install your licenses. For more information, 
see ”Activation keys for node-locked licenses” on page 90 or 
”Overview of manual license installation” on page 100.
Installation and Licensing Guide

85



7 | Licensing Maya 
 > Types of licenses
You must go through the process of obtaining and installing a 
license if:

• your license was not found in the Prekey or Webkey files

• you are installing Maya for the first time 

• you are changing to a new Maya package (for example, from 
Complete to Unlimited)

• you are relocating Maya to a different computer

• you are adding additional licenses to a floating license. For 
more information about floating licenses, see “Types of 
licenses” on this page.

New customers who purchase a single computer (node-locked) 
version of Maya receive a serial number in one of the following 
ways:

• in the CD holder within your Maya package (available from 
selected resellers)

• directly from the reseller where you obtained your copy of 
Maya 

• directly from Alias 

After installing Maya and entering the serial number, new 
customers obtain an activation key which licenses your copy of 
Maya. For more information, see ”Activation keys for node-locked 
licenses” on page 90.

Types of licenses

Node-locked, floating, and client licenses

There are two types of licenses you can purchase: node-locked or 
floating. 
Installation and Licensing Guide 

86



7 | Licensing Maya

 > What licensing does
Node-locked 

A node-locked license lets you run Maya only on the computer 
where the license is installed. 

Floating

A floating license lets several users run Maya from any computer 
on the same network. For example, if you install a license for five 
users on your network, up to five machines can run Maya at one 
time. 

Each user’s computer—called a client—gets a floating license from 
a computer that serves licenses—called the license server. The 
license server can also serve itself a license. 

What licensing does

The licensing process creates the license file, if necessary, and 
adds your new Maya license to the end of the license file. The 
location and name of the license file is:

• (Windows) C:\FLEXLM\aw_servername.dat or aw.dat, 
where servername is the name of your license server.

• (Mac OS X) /var/flexlm/aw_server.dat, aw_client.dat, 
or aw.dat.

Note If you purchased a parallel port or USB hardware lock 
(dongle) from Alias for your Maya for Windows license, 
see ”Licensing: Hardware lock devices” on page 28.

If you have problems configuring your hardware lock, 
see ”Confirming parallel port or USB driver activation” 
on page 132 or go to: 

www.alias.com/support/maya
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• (IRIX, Linux) /var/flexlm/aw.dat or /var/flexlm/
aw_servername.dat, where servername is the name of your 
license server. 

The licensing process comments out licenses for previous versions 
of Maya, but leaves them otherwise intact. Licenses are backwards 
compatible; that is, a Maya 6.5 license lets you run previous 
versions of Maya.

Licensing during installation

Prekey

If you are an existing Alias customer, your required licenses may 
already be installed for you when you install Maya, using the 
Prekey file on the Maya software CD. A message during the 
software installation tells you if the licenses were installed on 
some platforms. There may be a brief delay while the installation 
software searches the Prekey file.

If your license was found in the Prekey file by the install process, 
no further action is required. You can run and use Maya.

Even if you are an existing customer of Alias, your license may 
not be in the Prekey file; however, Alias provides several different 
ways for you to obtain and install your license. 

For more information, see “Webkey” on this page and ”Activation 
keys for node-locked licenses” on page 90.

Webkey

If you are an existing Alias customer and your licenses were not 
installed during installation, you can obtain and install your 
licenses from the Webkey file on the Alias Web site.
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Getting the Webkey using the Alias Product 
Configuration Wizard (recommended)

1 Start Maya. If you have not licensed Maya, the Product 
Configuration Wizard appears.

If the Product Configuration Wizard does not appear, you can 
launch it by doing one of the following:

• (Windows) Go to Start > Program Files > Alias > Maya 6.5 
> On-line Product Activation.

• (Mac OS X) In the Maya directory (by default, this is 
/Applications/Alias/Maya6.5/), double-click the Maya 
Product Activation icon. 

• (Linux, IRIX) Enter the following command in a shell:

/usr/aw/maya6.5/bin/opa

2 In the Product Configuration Wizard, click All Tasks.

3 Select Download license upgrades for Maya 6.5.
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4 Click Next.

5 You may be asked to identify a Web browser. Once you have 
chosen a Web browser, click Next.

A Web browser window opens, displaying the Maya Webkey 
web page. 

Instructions on this Web page describe how to download and 
install the Webkey file.

You can also browse to the following URL in your Web browser 
to obtain the Maya Webkey file:

www.alias.com/en/Community/Special/keys/maya/

Node-locked

Activation keys for node-locked licenses

The following procedures explain how to activate Maya online 
and license node-locked (single computer) versions of Maya 
Complete and Maya Unlimited.

New customers who purchase a single computer (node-locked) 
version of Maya receive a serial number in one of the following 
ways:

Note If you run Maya on several different operating systems, 
you need to download and install the Webkey file for all 
operating systems that currently have Maya licenses: for 
both license servers and any computers running Maya 
with a node-locked license. 

You do not need to download or install the Webkey file 
for any client machines that obtain their licenses from a 
license server.
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• in the CD holder within your Maya package (available from 
selected resellers)

• directly from the reseller where you obtained your copy of 
Maya 

• directly from Alias 

Maya serial numbers always begin with the letters ‘MC’ or ‘MU’. 
If you did not receive a serial number, contact your local Alias 
sales office or your reseller. 

You need a serial number in order to activate Maya online. 

After installing Maya and entering the serial number, new 
customers can obtain an activation key which licenses your copy of 
Maya. 

The following instructions apply to all supported platforms.

To obtain an activation key by online product 
activation

1 When you complete the install, start Maya.

The Alias Product Configuration dialog box appears (the 
appearance of this dialog box varies depending on which 
platform you’re running Maya).
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You see one of the two following messages in red text on a 
white background in the top portion of this dialog box:

• If no license file is available for use with Maya:

Maya 6.5 could not be started because there are no appropriate 
licenses installed on this computer. Please request and install your 
license using the options below.

• If there is a Maya license but it is for an earlier version of the 
software:

Maya 6.5 could not be started because the only available license on 
this computer is for a previous version of the software. Please use the 
options below to request and install your new license.
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2 From this dialog box, you can find the tasks needed to license 
Maya. You can filter the task list by selecting one of the 
following:

• Urgent Tasks (default)

• Recommended Tasks

• All Tasks

The following instructions give the recommended order for 
obtaining your activation key and licensing Maya. Follow 
these steps by selecting Urgent Tasks (the default).

3 Click Request an Activation Key for Maya 6.5 and click Next.

The following dialog box appears:

4 You are prompted to enter your serial number. Enter it and 
click Next.
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(Windows) A dialog box appears prompting you to make sure 
your USB or parallel port hardware lock (dongle) is 
connected, if you are licensing your machine via that method. 
If you are licensing via hardware lock and the hardware lock 
ID does not appear in the following hardware identifiers 
screen, we suggest you reboot your machine.

The following dialog box appears.

Your hardware ID (also known as the hardware identifier or 
Host ID) is listed in this dialog box. The hardware ID is a way 
of uniquely identifying your computer by using an encrypted 
form of your ethernet address (or parallel port/USB hardware 
lock).
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5 Click Next.

The following dialog box appears.

Note If there are multiple hardware IDs, choose the 
appropriate one. 

For example, if you are installing Maya to a laptop that 
has a dock, you may see two ethernet addresses, or a 
different ethernet address than the one that appears 
when the laptop is not docked. 

Make sure you choose the ethernet address that is 
always with your computer.

Note If you are using a parallel port or USB hardware lock 
device (dongle) to license Maya, you must choose the 
appropriate hardware ID (from the list that appears) 
that contains the FLEXID number for your hardware 
lock and not the Ethernet ID for your computer.

The hardware lock ID begins with the letter F, whereas 
the Ethernet address begins with the letter E. If the 
hardware lock ID does not appear in the list of 
hardware identifiers the hardware lock may not be 
properly attached or the Sentinel USB/parallel port 
driver may not be activated. For further information see 
”Confirming parallel port or USB driver activation” on 
page 132
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You need to request an activation key either online using a 
Web browser or by e-mail, phone, or fax. By default, only the 
web browser method is listed, but you can click Show All 
Ways of Making an Activation Request to see all methods.

6 Select the desired option and click Next. 
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• If you are obtaining your activation key via the web site, 
choose your browser in the next screen. Your browser 
launches and takes you to the Alias web site.

On the Alias Product Activation web site, fill out the form. 
Follow the online instructions to obtain your activation key.

When you submit your form, your activation key is sent to the 
email address listed. 

• If you selected phone, fax, or email, you are prompted to enter 
all the information Alias requires to process your activation 
key request. At the end of the entry process, you are 
prompted to email the message to Alias, or print the 
document to be faxed or mailed. Please note that this can take 
several days to process.

Note You can obtain an activation key for your computer 
running Maya even if it is not connected to the Internet. 
You must have another computer that is connected to 
the Internet.

1. Record the hardware ID of the computer that is not 
connected to the Internet from OPA. Also, have your 
serial number ready.

2. On the computer that is connected to the Internet, go 
to the following URL:

www.alias.com/cgi-bin/activation/activate.cgi

Enter the serial number, hardware ID, and other 
information from the computer you want to obtain an 
activation key for in the form provided. When you 
receive an activation key, follow the instructions in the 
next section (”To install your activation key” on page 98) 
on the computer you want to license. 
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To install your activation key

1 Once you’ve received your activation key via email (most 
common), fax, or mail, go to the Alias Product Configuration 
dialog box (you may need to restart Maya).

2 Choose Install Your Activation Key for Maya 6.5 and click 
Next. 

If Install Your Activation Key is not showing, click All Tasks 
and select it.

The following dialog box appears:
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3 Enter your activation key and click Next.

This automatically installs your node-locked license and you are 
prompted to start Maya.

Note On Windows, the Product Configuration Wizard may 
display a message indicating that you do not have 
permission to save the license file to the directory 
C:\FLEXLM. A file browser appears where you can save 
the license to a selected location. You need to have 
permissions set correctly on this directory to move the 
license file to the default location (C:\FLEXLM). At that 
point, you need to talk to a system administrator to get 
permissions to put the file in the correct directory.
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Manual license install

Overview of manual license installation

The instructions in this section refer to the manual installation of 
licenses. You need to follow these instructions for:

• all floating licenses 

• node-locked licenses where you didn’t receive a serial 
number.

Tip If you need to use the Product Configuration Wizard 
again, you can launch it by doing one of the following:

• (Windows) From the Start menu, go to 
Program Files > Alias > Maya 6.5 > On-Line Product 
Activation.

• (Mac OS X) Double-click the Maya Product 
Activation icon in the Applications/Alias/
maya6.5/ folder.

• (IRIX, Linux) Run /usr/aw/maya6.5/bin/opa

Note If you are a running a node-locked version of Maya 
(Maya Complete or Maya Unlimited), you may have 
already received a serial number allowing you to use the 
Product Configuration Wizard, which is faster and more 
convenient. For details, see ”Activation keys for node-
locked licenses” on page 90.
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Obtaining a license 

To obtain your license, you must send a request to Alias with 
your hardware ID and the products you want to license. Follow 
these instructions to find your hardware ID and send the request 
to Alias for each node-locked or license server machine. 

Getting your hardware ID values

(Windows) To find your computer’s hardware ID

1 Select Start > Programs > Alias > Common Utilities > FlexLM 
License Utilities.

The LMTOOLS window appears.

2 In the LMTOOLS window, click the System Settings tab.

3 If you have a parallel port or USB hardware lock, record the 
FLEXID value. Otherwise, record the Ethernet Address value. 

The value you record is your hardware ID.

4 Close the LMTOOLS window. 

Continue by sending in your license request. For more 
information, see ”Sending your license request” on page 102.

(Mac OS X, Linux, IRIX) To find your computer’s 
hardware ID

1 Open a shell or Terminal window.

2 Enter the following command to find your computer’s unique 
identifier:

/usr/aw/COM/bin/lmhostid

The lmhostid command is a license manager utility installed 
with Maya. When you enter this command, it returns machine 
information. For example:
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lmhostid - Copyright (C) 1989-2003 Macrovision 

Corporation. All rights reserved.

The FLEXlm host ID of this machine is "690c5c73"

The unique identifier is in quotes at the end of the returned 
value. In the above example, it is 690c5c73. Your returned 
value may have more digits, depending on your platform.

3 Continue by sending in your license request. For more 
information, see ”Sending your license request” on page 102.

Sending your license request

• On any browser (it does not need to be the same machine as 
the one currently being licensed), access and complete the 
online SPAR (Software Product Authorization Request) form 
at:

www.alias.com/spar/

Alias processes your request and provides you with the 
license via e-mail.

Installing licenses

If your license was not installed and you have obtained your valid 
Maya license from your reseller or Alias, follow these instructions 
for either node-locked or floating licenses.

For floating licenses, you must complete additional instructions: 
”Additional setup for floating licenses” on page 111.

Prerequisites

Before you install licenses, make sure you have done the 
following:

• installed Maya 6.5 software (you must at least have Maya 
licensing software installed)

• obtained your license in an e-mail from Alias. 
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• updated your licensing software on the machine serving 
Maya licenses to the most current version 

• (Windows) rebooted your machine if you intend to use a 
hardware lock provided by Alias (otherwise, ignore this 
prerequisite)

• (Windows) checked the following: for floating licenses the 
server and clients must each have a C: drive in order for the 
licenses to be served properly. 

Installing licenses from e-mail

For node-locked licenses, perform these steps on each machine 
running Maya. For floating licenses, perform these steps on the 
license server machine. 

In this section, we list how to install your license using the Alias 
Product Configuration Wizard on all supported platforms. This is 
the recommended procedure:

• ”Installing your license using the Product Configuration 
Wizard (recommended)” on page 104

Alternately, you can install your license manually on all 
supported platforms.

• Windows. See ”Installing your license manually on 
Windows” on page 107.

• Mac OS X. See ”Installing your license manually on Mac OS 
X” on page 109.

• Linux and IRIX. See ”Installing your license manually on 
Linux and IRIX” on page 110.
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Installing your license using the Product 
Configuration Wizard (recommended)

1 When you have received your license, start Maya.

If the Product Configuration Wizard does not appear, you can 
launch it by going to Start > Program Files > Alias > Maya 6.5 
> Install License.

2 You can choose to install your license by typing or pasting in 
your license, or from a file. Choose an option from the License 
Installation Method dialog box.

Note If your organization stores your license file somewhere 
other than the default location, then you need to point 
Maya to this in the maya.env file by updating the 
SGIAWD_LICENSE_FILE variable. This changes the 
license file location for all Alias products. For details, see 
Environment Variables. 
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3 If you choose to install your license from a file, you are 
prompted to browse for the file. If you choose to install your 
license by typing or pasting, you are presented with a text box 
to type or paste your license in.
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4 Type or paste in your license, or choose the license file.

The Product Configuration Wizard validates the license and 
notifies you of any problems during the process.

Note It is strongly recommended that you install the license to 
the default location. If you want to install the license to 
another location, turn off the Install to default license file 
option at the bottom of these dialog boxes. A file 
browser dialog box appears prompting you for a 
location to save the license file.
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If you are notified of an error during the process, please make 
sure you have typed or pasted in the license correctly, or chosen 
the correct license file. For more information on the messages that 
appear during the licensing process, click Details to help you 
diagnose the problem; you may need to give this information to 
an Alias Support representative.

For information on installing your license manually, without 
using the Product Configuration Wizard, see “Installing your 
license manually” on this page.

This concludes the process of licensing Maya if you obtained a 
node-locked license from Alias. Proceed to ”Confirming Maya 
startup” on page 122. If you are installing a floating license, 
continue with ”Additional setup for floating licenses” on 
page 111.

Installing your license manually

We recommend that you use the Product Configuration Wizard to 
install Maya licenses. For more information, see ”Installing your 
license using the Product Configuration Wizard (recommended)” 
on page 104. 

Installing your license manually on Windows

To install the license manually (Windows)

1 Go to the email you received from Alias with your license, 
and copy the license string. It appears as follows:

FEATURE MayaUnltd sgiawd 6.500 20-jan-2005 \

uncounted 70F9BD1AC42F \

HOSTID=FLEXID=7-b285e673

2 Please check if there is an aw.dat (node-locked license) or 
aw_servername.dat (floating license) file located within the 
C:\FLEXLM directory.
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If there is, paste or type the license into the top of the file and 
save it.

3  If there is no file or directory there, create the C:\FLEXLM 
directory.

4 Open Notepad (Start > Programs > Accessories > Notepad) 
and type or paste the license string into the new document.

5 Save the file from Notepad as aw.dat (node-locked license) or 
aw_servername.dat (floating license) within the C:\FLEXLM\ 
directory.

This completes licensing for this computer for node-locked 
licenses. Proceed to ”Confirming Maya startup” on page 122. If 
you are installing a floating license, continue with ”Additional 
setup for floating licenses” on page 111.

Note You need to make sure that the view options on the 
license directory (C:\FLEXLM) are set to show all files 
and full file extensions; that is, make sure that Hide 
Known File Extensions is not checked as one of your 
View options for the C:\FLEXLM folder.

If Hide Known File Extensions is checked, the file may 
be called aw.dat.txt and you only see it as aw.dat.

aw.dat.txt will not work as a license file

aw.dat will work as a license file.

To fix this, in the My Computer window or Windows 
Explorer window, select Tools > Folder Options and 
click the View tab. Turn on Show All Files and turn off 
Hide File Extensions For Known File Types. 
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Installing your license manually on Mac OS X 

You may need to create a su (superuser) account in order to install 
your license or start a license server. For more information, see 
”Enabling a superuser (su) account (Mac OS X)” on page 153. 

You copy the license file to your disk (only if you received your 
license via email).

(Mac OS X) To install the license by saving a license 
file

1 You should have already obtained a license via email from 
Alias. If you have not received a license, see ”Obtaining a 
license” on page 101.

2 Go to the email you received, and copy the entire license 
string. 

You don’t need to understand the contents of the license to do 
this procedure. For details, see ”Understanding licenses” on 
page 154.

3 Please check if there is an aw.dat (node-locked license) or 
aw_server.dat (floating license) file located within the 
/var/flexlm/ directory. If there is, use a text editor to paste 
or type the license into the top of the file and save it.

4 If there is no file or directory there, create the /var/flexlm/ 
directory by typing mkdir /var/flexlm in a Terminal 
window. You may need to be superuser to create this folder.

5 Use a text editor and type or paste the license string into a 
new file. Ensure this file is in plain text format as aw.dat 
within the /var/flexlm/ directory. Please check in the /var/
flexlm directory that the file is saved without a .txt 
extension.

Once the aw.dat or aw_server.dat file is in the /var/flexlm/ 
directory, you should be able to start up Maya. This completes 
licensing for node-locked licenses. Proceed to ”Confirming Maya 
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startup” on page 122. If you are installing a floating license, 
continue with ”Additional setup for floating licenses” on 
page 111.

Installing your license manually on Linux and IRIX

(IRIX and Linux) To install the license manually

1 Go to the email you received, and copy the license string. It 
looks like the following:

FEATURE MayaUnltd sgiawd 6.500 20-jan-2005 \

uncounted 70F9BD1AC42F \

HOSTID=7-b285e673

2 Please check if there is an aw.dat (node-locked license) or 
aw_servername.dat (floating license) file located within the 
/var/flexlm/ directory.

If there is, paste or type the license into the top of the file and 
save it.

3  If there is no file or directory there, create the /var/flexlm/ 
directory.

4 Use a text editor such as vi or emacs to create a file called 
aw.dat (node-locked license) or aw_servername.dat (floating 
license) in the /var/flexlm/ directory and type or copy the 
license string into this file. Make sure you save the file as 
aw.dat (node-locked license) or aw_servername.dat (floating 
license) within the /var/flexlm/ directory.
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Server setup

Additional setup for floating licenses

To configure your machines to serve and receive licenses across 
the network, you must set up the license server, then set up each 
client computer that obtains a license from the server. (Servers can 
serve a license to themselves.)

(Windows) License server management options 
and license server confirmation

To set options and start the license server

1 Select Start > Programs > Alias > Common Utilities > FlexLM 
License Utilities.

Note • If you are serving Maya 6.5 licenses, we strongly 
recommend that you install the current version of 
the server software on the license server and restart 
the license service.

• (Windows) The server and clients must each have a 
C: drive in order for the licenses to be served 
properly. If a server or client does not have a C: 
drive, you can set the environment variable 
SGIAWD_LICENSE_FILE. Please see Environment 
Variables. 

• Your license server can serve licenses to 
workstations on all supported platforms (Windows, 
Linux, IRIX, Mac OS X). This requires that the 
computers can access each other via TCP/IP. See 
”To initially set up an IRIX or Linux client” on 
page 118 for instructions.
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2 In the LMTOOLS window, click the Service/License File tab 
and select the Configuration using Services option.

3 Click the Config Services tab.

4 Turn on Use Services.

5 Turn on Start Server at Power Up.

6 Check that the values shown are correct:

• Path to the lmgrd.exe file is 
C:\Program Files\Common Files\Alias 

Shared\licensing\etc\lmgrd.exe

• Path to the license file is: 
C:\FLEXLM\aw_servername.dat, where servername is the 
name of the license server machine.

7 Click Save Service.

8 Click the Start/Stop/Reread tab and click Start Server.

(Windows) To confirm the license server operation

1 Click the Server Status tab.

2 Click Perform Status Enquiry.

If the license server is up, the window displays:

<servername>:license server UP(MASTER)

where servername is the license server computer name. The 
text area should also list the products/features and the 
number of logins you have.

3 Close LMTOOLS.

Note The path to the debug log file is optional and can be left 
blank.
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(Windows) To stop and start the license server

1 On the machine you want to license, click the Start menu and 
navigate to the Alias program group.

2 From Common Utilities, select FlexLM License Utilities.

3 In the LMTOOLS window, Service/License File tab, make 
sure Configuration using Services is turned on.

4 Click the Start/Stop/Reread tab and click the Stop Server and 
then the Start Server buttons. 

(Windows) Checking whether the license server is 
running 

You can use the Windows Task Manager to tell whether the 
license server is running. Do the following steps on the license 
server computer.

To check license server status

1 Press Ctrl+Alt+Delete on your keyboard.

2 Click Task Manager.

3 Click the Processes tab.

If lmgrd.exe and sgiawd.exe are in the list of processes, the 
license server is up. If neither are in the list, the license server 
is down. If only one is in the list, the license server is partially 
up. In this case, restart the computer.

(IRIX and Linux) License server management 
options and license server confirmation

(IRIX and Linux) To start the license server 

1 Log in as root if you have not done so. 

2 (IRIX) Enter this command:

/etc/chkconfig -f aw_flexlm on
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This ensures that the aw_flexlm script is installed in /etc/
init.d and ensures the aw_flexlm script is turned on.

3 Stop then start the lmgrd daemon by entering the following 
commands: 

/etc/init.d/aw_flexlm stop

/etc/init.d/aw_flexlm start

• If the server was on previously, the command issues some 
status information. An example of this status information is:

lmdown - Copyright (C) 1989-2003 Macrovision 

Corporation. All rights reserved.

Shut down FLEXlm server on node servername 1 FLEXlm 

License Server shut down

• If the server is already off, the command issues an error 
message similar to:

lmdown - Copyright (C)2003 Macrovision Corporation. 

All rights reserved.

Connection to "servername" failed: Cannot connect 

to license server(-15,12:146) Connection refused

where servername is the name of the server machine. You can 
ignore this error message.

• If the server starts successfully, the status message should 
look similar to this:

License file = /var/flexlm/aw_servername.dat

FLEXlm Licensing daemon for Alias software: /usr/

etc/lmgrd

4 Log out of root.

Additional troubleshooting steps

If you are having problems starting your licensing server, and 
stopping and then restarting your service as in the above 
instructions does not solve your problem, do the following:
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1 Type the following, and then press Return.

killall lmgrd

2 Type the following, and then press Return.

(IRIX) /usr/etc/lmgrd -c /var/flexlm aw_servername.dat

(Linux) /usr/aw/COM/etc/lmgrd

3 View the log file at the following location.

/usr/tmp/aw_flexlm.log

4 Type the following, and then press Return to see if the license 
manager is running in the process list.

ps -aef | grep lmgrd

This confirms that the daemon is now running.

For further information on troubleshooting floating license issues 
see ”Troubleshooting licensing problems (IRIX, Linux, 
Mac OS X)” on page 133

(Mac OS X) License server management 
options and license server confirmation 

(Mac OS X) To start the license server 

1 Log in as superuser (su).

You may need to create a su (superuser) account in order to 
install your license or start a license server. For more 
information, see ”Enabling a superuser (su) account 
(Mac OS X)” on page 153. 

2 Start the license server by typing the following in Terminal.

 /usr/aw/COM/bin/aw_flexlm start

Note Mac OS X Server is not supported by the FLEXlm 
licensing software.
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3 To confirm the server has started, type the following in 
Terminal:

 /usr/aw/COM/bin/lmstat -c /var/flexlm/aw_server.dat

4 If the server has started successfully, you should see output 
that contains the line “License server UP (MASTER) v9.2”.

5 Launch Maya to see if the licensing setup has worked.

Client setup

Setting up each client

To set up each client, you must add information to each client 
computer’s aw_servername.dat file (on Mac OS X, 
aw_client.dat). 
 

To set up a Windows client

1 Make sure the license server and Windows client can access 
each other through your TCP/IP network.

2 From the Start menu, choose Programs > Alias > Maya 6.5 > 
Install License. 

The Install License screen of the Product Configuration 
Wizard appears.

3 Choose “I would like to type or paste in my license file” and 
click Next.

Note You can run Maya locally on the license server computer 
using its existing aw_servername.dat or 
aw_server.dat file, so you don’t need to do the 
following steps on the server.
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4 In the text area provided, type or copy the first line from the 
license text provided by Alias. 

For example, from a server using an Ethernet Address:

SERVER server 0 7111

or from a server using a FLEXID:

SERVER server FLEXID=7-b1234a12 7111

5 Change the word server in the first line to match your machine 
name. For example, if the machine is myserver, it would 
appear like this:

SERVER myserver 0 7111

6 On the second line, type the following:

USE_SERVER

Your text should now appear similar to the following 
example:

SERVER myserver 0 7111

USE_SERVER

The SERVER and USE_SERVER lines tell the client which 
computer serves the licenses.

7 Press Enter to leave a blank line at the end.

Errors in the license are highlighted in red; the text turns 
black when the license is valid.

8 Click Next to save the file to the default location C:\FLEXLM. 

The License Installation Results screen appears. You can click 
Show Details if you want more information on the license that 
was installed. 

While you can go through this series of steps on each 
machine, once you have created the first aw_servername.dat 
file, you can copy it to the C:\FLEXLM directory on the other 
clients.

This completes the licensing procedure for floating licenses.
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To initially set up an IRIX or Linux client 

1 Make sure the license server and IRIX or Linux client can 
access each other through your TCP/IP network.

2 On each client machine, create the following text file with a 
text editor such as vi, jot, or nedit: 

/var/flexlm/aw.dat

or

/var/flexlm/aw.servername.dat

3 Type or copy this line from the license text provided by Alias. 
For example:

SERVER server 0 7111

4 Change the word server to match the name of your server. For 
example, if the server name is myserver, it would appear like 
this:

SERVER myserver 0 7111

5 On the second line, type the following:

USE_SERVER

Your file should now look like the following example:

SERVER myserver 0 7111

USE_SERVER

6 Press Enter to leave a blank line at the end.

7 Save the file and exit the text editor.

Note You can use an IP Address instead of the name of the 
server. For example, a license file named 
aw_myserver.dat on a client machine that is 
referencing the IP address would look like this:

SERVER 10.0.0.10 0 7111

USE_SERVER
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While you can go through this manual series of steps on each 
machine, once you have created the first aw_servername.dat file, 
copy it to the /var/flexlm directory on the other clients. If there 
are DOS control characters in the license file (that is, if you have 
copied it from a Windows client), remove them by typing the 
following command in a UNIX shell:

tounix /var/flexlm/aw_servername.dat 

To set up a Mac OS X client

1 On your computer, open the /var/flexlm/aw_client.dat 
file in a text editor.

2 On the first line, type SERVER (space) the host name of the 
server (space) 0 (space) 7111 (enter). On the second line, type 
USE_SERVER.

For example:

SERVER licenseserver 0 7111

USE_SERVER

The number 7111 is the port number used by FLEXlm on the 
server. If your site administrator has customized the server to 
use a different port for some reason, enter that number 
instead of 7111.

3 Save the file. If you used the TextEdit application to edit the 
file, remember to save the file as plain text without a .txt 
extension.

While you can go through this manual series of steps on each 
machine, once you have created the first aw_client.dat file, 
we suggest you copy it to the /var/flexlm directory on the 
other clients.

This completes the licensing procedure for floating licenses.
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Limiting the use of Maya Unlimited 
product licenses

Some users on your network may not need to use all the Maya 
features available to them. You can disable availability of optional 
licenses for specific users to ensure that those who need them 
have them on demand. 

For example, suppose your network has several Maya Complete 
licenses, but only one Unlimited license. To prevent some users 
from using the Unlimited license, you may control which users 
receives the Unlimited license.

To control the Maya product users can launch on all platforms, 
you can include a line in the user’s Maya.env file, for example:

MAYA_LICENSE = complete

For details on how to set up the Maya.env file, see the Environment 
Variables guide.

Alternatively, you can set an environment setting.

(Windows) To control Maya product availability for a 
user 

1 Log on to the user’s account.

2 From the Start menu, select Settings > Control Panel.

3 Double-click the System icon.

4 Click the Advanced tab.

5 Click Environment Variables.

6 Click New in the user variables box.

7 In the Variable Name text box, type MAYA_LICENSE.

8 In the Variable Value text box, type the appropriate setting 
from the following table.
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9 Click OK twice.

You can set this environment variable on a Linux or IRIX system 
in a variety of ways depending on your shell. You can also set 
environment variables on every login by putting them in a dot-file 
(.cshrc, .profile, or .login).

Sometimes, a user may need to use Maya Unlimited temporarily. 
Instead of editing the startup file, you can inform the user to start 
Maya with the following command, which overrides the startup 
setting:

maya -lic=unlimited

Other considerations

• If you repeat a command option or MAYA_LICENSE setting, 
Maya uses the last setting. 

• A command line option takes precedence over a conflicting 
environment variable setting. 

MAYA_LICENSE 
setting

Effect on Maya

complete Runs Maya Complete only

unlimited Runs Maya Unlimited only

Note If Maya license is set to Complete and there are no 
Complete licenses available, even if there are Unlimited 
licenses, the software will not run, but will display a 
“No Licenses Available” message.
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Finishing installation

Confirming Maya startup

Start Maya to confirm installation.

To confirm you installed Maya correctly

• (Windows) Do one of the following:

• Start Maya from the Start menu

• If you created a shortcut to Maya when prompted during 
installation, double-click the shortcut on your desktop. 

• (Mac OS X) Double-click the Maya icon in the Maya folder 
(Applications > Alias > Maya6.5), or select it from the Dock if 
you added it.

• (Linux and IRIX): In a shell, enter: maya

The main Maya window opens.

The display of the main Maya window confirms you’ve installed 
Maya. 

If an error message appears instead of the Maya window, it’s 
possible you have a licensing problem. See ”Troubleshooting” on 
page 127.

If the Product Configuration Wizard appears, Maya was unable to 
find a suitable license. See ”To obtain an activation key by online 
product activation” on page 91. 
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Additional licensing information

Verifying license server installation (all 
platforms)

If you are installing floating licenses, you must check to see that 
you have the correct version of the license server software.

Windows

Ensure that you installed the Licensing component when you 
installed Maya 6.5. This component is installed by default. 

(Windows) To verify license server version

• Do both of the following:

• At the Command Prompt, type:

"C:\Program Files\Common Files\

Alias Shared\Licensing\etc\lmgrd" -v

• At the Command Prompt, type:

"C:\Program Files\Common Files\

Alias Shared\Licensing\bin\lmutil.exe" -v

You should have version 9.2 installed of both. If not, you must 
update the license software on the license server from the Maya 
installation distribution.

Mac OS X

Ensure that you installed the License Server component when you 
installed Maya 6.5. This component is usually installed by default.

(Mac OS X) To verify license server version

• Open a Terminal window and type:

/usr/aw/COM/etc/lmgrd -v
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You should have version 9.2 of the license server daemon 
installed. If not, you must update the license software on the 
license server from the Maya installation distribution.

Linux

Ensure that you installed the latest version of the License Server 
software. You need to explicitly install this component. 

(Linux) To verify license server version

• In a shell window, type:

rpm -qa | grep AW

If the response is the following, you have the correct versions 
installed:

AWCommon-6.3-1

AWCommon-server-6.3-1

If not, you must uninstall the older packages and install the 
current ones.

Please see ”Uninstalling Maya” on page 72 and ”Installing Maya 
using the rpm utility” on page 68 for details on how to uninstall 
old packages and install the AWCommon-6.3-1.i686.rpm and 
AWCommon-server-6.3-1.i686.rpm packages.

IRIX

Ensure you have the license server components installed by doing 
the following:

(IRIX) To verify license server version

1 Do one of the following

• Open the Software Manager (swmgr) 

• Type versions -n license_eoe awcommon
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2 You must have the following components installed: 

• Alias Common Utilities 6.2 (awcommon). Make sure you 
have installed the Alias License Server Software 
subsystem (awcommon.sw.server). 

• License Tools 3.4.10 (license_eoe). Make sure you have 
installed the FLEXlm 9.0 Server Software subsystem 
(license_eoe.sw.flexlm_server).

To install FLEXlm server software

1 Log into the license server machine as root.

2 Insert the Maya 6.5 IRIX CD into the drive.

3 At the command line, type swmgr.

4 Enter the path to the CD-ROM at the top of the Software 
Manager window, such as /CDROM/dist.

If you have a remote CD-ROM drive, specify its path. For 
more information, see ”Accessing a remote CD-ROM” on 
page 59.

5 Click Lookup. 

6 Click Execute (or OK) after reading the installation 
instructions. 

7 When the Software Manager window reappears, click the 
Customize Installation button.

8 Select Alias Common Utilities, 6.2 and then click the button to 
expand the product’s sub-products.

9 Turn on the check boxes for Alias Common Base Software, 
Alias Common Desktop Software and Alias License Server 
Software.

10 Select License Tools 3.4.10 and then click the button to expand 
the product’s sub-products.
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11 Turn on check boxes for:

• FLEXlm 9.0 Server Software 

• FLEXlm 9.0 Utilities

• License Manager 3.4.10 Software

12 Click Start.

13 When the installation is completed, select Exit and click OK.
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Troubleshooting installation and 
licensing

This chapter describes troubleshooting for Maya installation and 
licensing. During installation, the installer displays error messages 
in response to problems. After installation and licensing, if you 
start Maya and the Product Configuration Wizard and/or error 
messages appear rather than the Maya main window, you may 
have a specific startup problem or a licensing problem. 

• ”Installation troubleshooting” on page 128

• ”Startup problems” on page 131

• ”Licensing troubleshooting” on page 133

If you feel you’re not making progress while troubleshooting, 
please go to our support Web site, where you’ll find information 
that may help solve your problem.

www.alias.com, and click Support and then Maya.

As well, you can contact our Support Services department for 
assistance.

Contacting Support Services 

North America 

Hours: Monday to Friday, 9:00 am to 8:00 pm EST
Platinum Customers:
Toll-free from U.S. and Canada: 877-927-7478
Elsewhere in the Americas: 416-362-8670 
Fax: 416-369-6138
E-mail: hotline@alias.com
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Incident Support:
Toll-free from U.S. and Canada: 800-747-9208
Elsewhere in the Americas: 416-362-8670

Europe

Hours: Monday to Friday, 9:00 CET to 18:30 CET
Single Incident Support Service & Maintenance Customers:
Toll-free from Germany: 0800-1827660 
Toll-free from UK: 0800-7318923 
Toll-free from France: 0800-902295 
Toll-free from Italy: 800-780809 
All others (toll call): +32 9 223 6945 
Fax: +32 9 266 12 30
E-mail: hotline_esc@alias.com

Asia-Pacific

Please contact your local reseller for support service. 

Installation troubleshooting
This section gives details on problems that may occur during 
installation.

(Windows) Installer error messages 

This section explains error and status messages that may occur as 
you run the Maya installer on Windows. For details on error 
messages that may occur when you start or run Maya, see 
”(Windows) Issues at startup” on page 131 and ”Troubleshooting 
licensing problems (Windows)” on page 136.

Hardware lock (dongle) problems

When the installation procedure works correctly, it installs and 
activates the Sentinel parallel port and USB device driver that 
communicates via your computer’s parallel or USB port when the 
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hardware lock is installed. This is necessary for correct license 
operation. If the procedure failed to activate the device driver, you 
must reboot your machine or activate it as described in 
”Confirming parallel port or USB driver activation” on page 132.

(IRIX) Software Manager troubleshooting 
& FAQ 

The following section refers to problems you may have when 
using Software Manager on IRIX.

Q Software Manager is not behaving as described in the 
installation instructions. 

A Your Software Manager may be customized, as specified by 
the /var/inst/.swmgrrc file. Try renaming this file (for 
example, to oldswmgrrc) and restarting Software Manager to 
be sure it is in default mode. 

Q The installation doesn’t seem to be working. What should I 
do? 

A In Software Manager, enter the /CDROM/dist location in the 
text field, then click the Lookup button. This takes you back to 
the beginning of the installation process.

Q An “Alias Installation Error” window appears. What do I do?

A You may be missing prerequisite IRIX software or patches. 
Follow the displayed instructions before continuing with the 
installation. The missing components may be SGI software 
patches. Some patches may be on the IRIX CD-ROM, but the 
best place to get patches is on the SGI Web site. For a list of 
qualified patches, refer to our Web site: www.alias.com/
qual_charts.
Installation and Licensing Guide

129



8 | Troubleshooting 
 > (IRIX) Software Manager troubleshooting & FAQ
Q Software Manager reports a conflict.

A Software conflicts are caused by several different reasons. 
Click Conflict and choose from the list of possible solutions. 

To help prevent software conflicts:

• Do not click Cancel in the Installation Software Script 
window. 

• Do not click the Default Installation button in the 
Software Manager window.

Q Software Manager reports a conflict related to a software 
patch for the “Java Runtime System Software”.

A This particular Java software patch is incompatible with the 
Maya installation and must be removed to successfully install 
Maya. Follow the instructions provided in the Software 
manager window.

Q Software Manager says I don’t have enough space on /usr 
even though I’m installing to a different file system.

A This is a limitation in some versions of the Software Manager. 
Make sure there is enough room in the file system, then type 
the following in the command line to disable space-checking:
set override_space_check true

Q How do I remove Maya?

A Always use Software Manager or inst to remove Maya files. 

If you are using Software Manager, click Manage Installed 
Software, select Alias Maya, then click Start. 

If you also installed the Developer’s Tool Kit or other optional 
software, you must remove it as well.
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Startup problems
The following section deals with problems occurring at startup 
that are not license related. 

(Windows) Issues at startup 

Preference corruption

If you are having problems starting Maya after installation and 
you believe everything is licensed correctly, your preferences may 
have become corrupted. 

You can force Maya to restore your preferences file. Rename your 
existing user preferences file; for example, prefs.backup, and 
then restart Maya. 

The default prefs directory path is:

• (Windows) drive:\Documents and Settings\username\My 
Documents\maya\6.5\prefs

• (Mac OS X) Users/username/Library/Preferences/Alias/
maya/6.5/prefs

• (IRIX and Linux) ~username/maya/6.5/prefs

The Product Configuration Wizard does not 
appear

If you are attempting to enter your serial number or activation 
number and the Product Configuration Wizard does not appear 
when you started Maya (and Maya does not run), select Start > 
Programs > Alias > Maya 6.5 > Online Product Activation.

If the Product Configuration Wizard still doesn’t open you may 
have a damaged or incomplete install. Try reinstalling Maya.
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The main Maya view port doesn’t open, but the 
Script Editor does

This is usually due to incorrect graphic card drivers on the 
machine. Check that the qualified graphic card drivers are 
installed. 

Confirming parallel port or USB driver 
activation

The Sentinel driver enables communication between a node-
locked computer and its parallel port/USB port, or between the 
license server computer and its parallel port/USB port. The 
parallel port or USB port connector is where the hardware lock is 
attached. 

The installer upgrades the Sentinel driver unless the current 
version already exists on your computer. 

There are several steps to make sure that the driver is installed 
and active:

• After install: reboot to activate drivers. This should fix most 
problems.

• In some circumstances—such as plugging the hardware lock 
in before an install on a machine that is not connected to the 
Internet—a generic USB driver may be installed for the 
hardware lock. In this case, we recommend the following:

•  Download Win32 device drivers from the following URL:

www.ealaddin.com/support/hasp/enduser.asp

• Uncompress and install the downloaded file. 

Once this is installed, the Device Manager should recognize 
the USB dongle as an Aladdin USB Key. You may need to 
reboot.
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Licensing troubleshooting
The following section deals with problems starting up Maya due 
to a licensing problem.

When you start Maya

If the Product Configuration Wizard appears at startup, make 
sure you have licensed your copy of Maya correctly by checking 
the licensing steps starting in ”Licensing Maya” on page 85, and 
also checking the following:

• You may have one or more environment variables set that 
affect licensing. Check your environment variables and your 
Maya.env file for SGIAWD_LICENSE_FILE, MAYA_LICENSE or 
MAYA_ALT_EN settings.

• Check for the existence of files in the license directory 
(Windows: C:\FLEXLM; Mac OS X, IRIX, Linux: 
/var/flexlm/) that begin with aw and end with the extension 
.dat. It is possible that you have a corrupt or expired license 
file that is misleading Maya that you are attempting to 
connect to a license server. This may prevent the Product 
Configuration Wizard from launching.

If the Product Configuration Wizard appears or Maya main 
window doesn’t appear at startup, and you have followed the 
licensing steps correctly, please review the platform-specific 
troubleshooting information below. 

Troubleshooting licensing problems 
(IRIX, Linux, Mac OS X)

If the following error message appears, do the steps under the 
appropriate headings that follow.

No license suitable to run this version of Maya

Error setting license default
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Cannot find any aw.dat (or aw_servername.dat) files 
in /var/flexlm

Unable to locate a license server for Maya

Account is not available

Do the steps in sequence until the problem is solved. If you’ve 
tried all steps or you see an error message not listed, write down 
the exact error message and call our Support Services department.

No license suitable to run this version of Maya or 
Error setting license default

1 If you tried to run Maya on a client or server, make sure the 
time and date on the client and server are correct and 
synchronized. If the time and date of the client differs from 
the server by more than a half hour, the client may not be able 
to get a license.

2 Review the licensing procedure to make sure you completed 
all the steps.

3 Do the steps in ”Examining a licensing log file” on page 138. 

Cannot find any aw.dat (or aw_servername.dat)
 files in /var/flexlm

1 Verify that the /var/flexlm directory contains the file aw.dat 
or aw_servername.dat.

2 If this file doesn’t exist, you may have not done the steps 
required in ”Licensing Maya” on page 85. You’ll need to 
reinstall licenses.

Unable to locate a license server for Maya

Note This message occurs only with floating licenses. 
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To check possible client problems

• Verify that the USE_SERVER line is below the SERVER line in 
the client license file. For an example, see ”Setting up each 
client” on page 116.

To check possible server problems

1 Verify that you have installed the proper version of the 
licensing software. For more details, see ”Verifying license 
server installation (all platforms)” on page 123.

2 Stop and start the license server software as described in 
”Additional setup for floating licenses” on page 111. 

3 If that does not solve the problem, do the steps in ”Examining 
a licensing log file” on page 138.

Account is not available

When attempting to set up a Linux floating license server, and 
after typing the following command to start flexlm:

/etc/init.d/aw_flexlm start

You receive the following error:

Account is not available

One possible cause of this problem is that the nobody account 
which serves the licenses on the server has its login shell set to 
/sbin/nologin within the /etc/passwd file. 

To correct the ‘nobody’ account problem

1 In a shell window, edit the /etc/passwd file on the server.
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2 Change the entry for the “nobody” account as in the following 
example:

nobody:*:99:99:Nobody:/:/sbin/nologin

to:

nobody:*:99:99:Nobody:/:

Troubleshooting licensing problems (Windows)

If the Maya main window doesn’t appear, one of the following 
error messages may appear:

No license suitable to run this version of Maya

Error setting license default.

Unable to locate a license server for Maya.

Cannot find any aw*.dat files in C:\flexlm\.

No licenses found for your FLEXid flexid

For the message that appears, do the steps under the appropriate 
heading that follows. In each case, do the steps sequentially until 
the problem is solved. If you’ve tried all steps or you see an error 
message not listed, write down the exact error message and call 
our Support Services department.

The last message in the above list may occur as you run the 
License Installer software, not as you run Maya.

No license suitable to run this version of Maya or
Error setting license default

1 If you are using a FLEXlm Hardware Lock, make sure you 
attached the hardware lock correctly. See ”Licensing: 
Hardware lock devices” on page 28 for installation details.

2 Confirm that the Sentinel driver for the Hardware lock device 
is correctly activated. See “Confirming parallel port or USB 
driver activation” on page 132.
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3 If you tried to run Maya on a client or server, make sure the 
time and date on the client and server are correct and 
synchronized. If the time and date of the client differs from 
the server by more than a half hour, the client may not be able 
to get a license.

4 Review the licensing procedure to make sure you completed 
all the steps.

5 On the appropriate node-locked computer or license server 
computer, make sure the parallel port or USB port is 
operational if you are using a FLEXlm Hardware Lock. There 
are no easy ways to check that the port is operational other 
than to plug a printer (or some other device) into the parallel 
port or USB connector and print something.

6 Do the steps in ”Examining a licensing log file” on page 138.

7 Do the steps in ”Checking for licensing errors with FLEXlm 
licensing utilities (Windows)” on page 149. 

Unable to locate a license server for Maya

To check possible client problems

• Verify that the USE_SERVER line is below the SERVER line in 
the client license file. For an example, see ”Setting up each 
client” on page 116.

• Make sure that your client and the license server are 
connected via a TCP/IP network. 

To check possible server problems

• Stop and start the license server software as described in 
”Additional setup for floating licenses” on page 111. 

Note This message only occurs with floating licenses. 
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Cannot find any aw*.dat files in C:\flexlm\

1 From My Computer or Windows Explorer, verify that the 
C:\FLEXLM\ directory contains the file aw.dat or 
aw_servername.dat.

If this file doesn’t exist, you’ll need to redo the licensing 
procedure as described in ”Licensing Maya” on page 85.

2 Do the steps in ”Checking that a license file is the correct file 
type (Windows)” on page 152.

No licenses found for your FLEXid flexid

• You don’t have any licensing information in the license file.

• If the licensing information originates in an e-mail or other file 
of an IRIX or Linux computer and you transfer the file to the 
Windows computer, you must transfer it in ASCII mode 
rather than binary. Otherwise the file will contain additional 
control characters at line endings that the License Installer 
won’t recognize, and you’ll see the preceding error message.

You can use Notepad to examine the contents of the file on 
the Windows computer to make sure it has no added control 
characters. 

Examining a licensing log file

If you start Maya and the Product Configuration Wizard or error 
messages appear instead of the Maya main window, you can 
create and examine a licensing log file to learn the nature of the 
error. Error messages may include:

No license suitable to run this version of Maya

Error setting license default.

For a node-locked license, do the following steps on the computer 
where the message appears. For a floating license, do the 
following steps on the license server computer. 
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To examine the license error log file (Windows)

1 From the Start menu, select 
Programs > Accessories > Command Prompt

2 At the Command Prompt, enter:

set FLEXLM_DIAGNOSTICS=2 

3 To repeat the failed attempt to start Maya, use the full path:

<install_path>\maya

where install_path is the path to which you installed the Maya 
software. For example, if you installed Maya on drive C:, the 
path would be: C:\Program Files\Alias\Maya6.5\maya.

When you set the FLEXlm diagnostics in step 2, the attempt to 
start Maya creates a licensing log file. An error message 
flashes onscreen before the Product Configuration Wizard 
appears.

4 Open the log file that was just created:

• Using Windows Explorer, navigate to the folder in which 
you gave the command to start Maya. For example, if you 
typed <install_path>\maya at the C:\ prompt, the log 
file is created in the root folder of the C:\ drive.

• Open the file using Notepad or another text editor.

5 Find the message in ”Understanding log file error messages” 
on page 140 and follow the instructions. 

Ignore other information in the file. If the message isn’t listed, 
call Alias Support.

To examine the license error log file (IRIX, Linux, 
Mac OS X)

1 In a shell (IRIX, Linux), or in a Terminal window (Mac OS X), 
enter the following:

setenv FLEXLM_DIAGNOSTICS 2 
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2 (IRIX, Linux) Type maya to repeat the failed attempt to start 
Maya.

The diagnostic information is printed to the screen. As well, 
the Maya Product Configuration Wizard appears.

(Mac OS X) Type the following to start Maya. 

/Applications/Alias/maya6.5/Maya.app/Contents/MacOS/Maya

Only use this command to perform FLEXlm diagnostics. This 
special command ensures that the startup attempt inherits the 
FLEXLM_DIAGNOSTICS environment variable from the typed-in 
command.

The diagnostic information is displayed in the Terminal 
window. As well, the Maya On-line Product Activation 
window appears.

3 The FLEXlm checkout error message always refers to the 
FEATURE below it. The format is:

• FLEXlm checkout error.

• License file being used.

• FLEXlm error code and FEATURE line in question.

4 Find the message in the following topic, ”Understanding log 
file error messages” on page 140 and follow the instructions. 

Ignore other information in the file. If the message isn’t listed, 
call Alias Support.

Understanding log file error messages

Error messages within the file help you identify the problem. The 
most common error messages are explained below. If multiple 
errors exist, look for the feature name that matches the feature in 
your license file. Use the help in step 3 above to focus on the error. 
In the following explanations, license file refers to the aw.dat file 
for node-locked licenses, and aw_servername.dat (on the server) 
for floating licenses.
Installation and Licensing Guide 

140



8 | Troubleshooting

 > Examining a licensing log file
Error Possible solutions

FLEXLM checkout 
error: Invalid 
(inconsistent) 
license key. The 
license key and data 
for the feature do 
not match. This 
usually happens when 
a license file has 
been altered.

• Check the license file for a 
typing mistake in the 
password, expiration, or 
license version. If it is a 
floating license, check to see if 
the HOSTID is spelled 
correctly. As well, check the 
spelling and punctuation in 
the ISSUER field.

• If you obtained a pre-release 
license for Maya, also check 
the spelling of eval or edu in 
the VENDOR_STRING.

FLEXLM checkout 
error: Feature has 
expired...

• Either the current machine 
date is later than the expiration 
date or there’s a typing 
mistake in the expiration date. 

FLEXLM checkout 
error: Invalid date 
format in license 
file

• Check the license file’s 
expiration date for an incorrect 
format, for example, may-4-
2003. The correct format is 4-
may-2003. 

• The password may have 
invalid characters—not all 
hexadecimal.

• The license count digit may be 
absent: uncounted for node-
locked, a number greater than 
0 for floating.
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FLEXLM checkout 
error: Invalid 
License File syntax.

• Check the entire license file for 
a typing mistake.

FLEXLM checkout 
error: No such 
feature exists.

• Check the license file’s spelling 
of components, package, and 
feature lines.

FLEXLM checkout 
error: Future license 
file format or 
misspelling in 
license file. 

• Check the license file’s spelling 
of VENDOR or any part of the 
string HOSTID number. 

• Windows hardware lock (dongle) 
users: Check the license file’s 
spelling of VENDOR or any 
part of the string 
HOSTID=FLEXID=number. 

• Check that you typed \ instead 
of / at the end of a line.

• Check that the ISSUER is 
spelled correctly.

FLEXLM checkout 
error: No SERVER 
lines in license 
file. 

• For a node-locked license, 
check that the license file’s 
License Count is uncounted.

• For a floating license, make 
sure the appropriate SERVER 
and VENDOR/DAEMON 
lines appear at the top of the 
aw_servername.dat file 
(where servername is the 
name of the license server 
machine). On Mac OS X, this 
file is named aw_server.dat.
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FLEXLM checkout 
error: Maya license 
in file appears to be 
corrupted. 

• Check the entire license file for 
a typing mistake.

FLEXLM checkout 
error: Invalid host. 

or

The hostid of this 
system does not match 
the hostid specified 
in the license file. 

• Check that the machine 
possesses the right hardware 
ID/HOSTID number, and that 
it is correct and not misspelled. 

• To check the hardware ID of 
the current machine, see 
”Getting your hardware ID 
values” on page 101.

• Check that the hardware lock 
(dongle) is plugged into the 
parallel port or USB port 
correctly. See ”Licensing: 
Hardware lock devices” on 
page 28.

FLEXLM checkout 
error: No server for 
this feature.

• sgiawd in DAEMON (IRIX, 
Linux) or VENDOR 
(Windows, Mac OS X) line 
may be spelled incorrectly.

FLEXLM checkout 
error: License server 
does not support this 
feature.

• Check the license file to see if 
the feature has expired, the 
license server has not yet 
started, or the version is higher 
than the highest supported 
version. 

• Try using the computer’s IP 
address instead of the 
hostname. 
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FLEXLM checkout 
error: Cannot connect 
to license server.

• FLEXlm floating license software 
has not been installed (see 
”Verifying license server 
installation (all platforms)” on 
page 123) or an older version of 
FLEXlm floating license software 
is installed. Maya 6.5 uses 
FLEXlm version 9.2.

• The license server has not been 
started.

• SERVER servername has not been 
changed to reflect the name or 
I.P. address of the server.

• DAEMON or VENDOR is not 
spelled correctly.

• (IRIX) The sgiawd path is not 
right. The default should be: /
usr/aw/COM/etc/sgiawd. 

• Check the network connection 
on your client machine.

• As a last resort, reboot your 
license server.

FLEXLM checkout 
error: Clock 
difference too large 
between client and 
server.

• Make sure the time and date on 
the client and server are correct 
and synchronized. If the time 
and date of the client differs 
from the server by more than a 
half hour, the client may not be 
able to get a license.
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Finding licensing problems with 
diagnostic tools 

For IRIX, Linux, and Mac OS X, you can use the lmhostid, 
lmdiag, and lmstat utilities to help find and fix licensing 
problems. For Windows, you can use the FLEXlm Licensing 
Utilities (lmtools) to help find and fix licensing problems.

Checking your hardware ID with lmhostid 
(IRIX, Linux, Mac OS X)

The lmhostid tool provides the hardware ID for the current 
machine. This should correspond with the Host ID in the aw.dat, 
aw_servername.dat, or aw_server.dat file. If they do not match, 
make sure that a typing mistake was not made. 

(IRIX, Linux, Mac OS X) To verify hostid information

1 In Terminal or in a shell, type the following:

/usr/aw/COM/bin/lmhostid 

2 Press Return. 

The result is displayed on the screen.

Diagnosing your licensing problems with 
lmdiag (IRIX, Linux, Mac OS X)

The lmdiag tool diagnoses problems when a license checkout 
fails. You can use it for node-locked or floating licenses. lmdiag 
first prints information about the license. It then attempts to check 
out each license. If the checkout is successful, lmdiag notifies the 
user; if not, lmdiag gives the reasons why the checkout failed.

• Do one of the following:

• (IRIX) At a UNIX prompt, type: 

lmdiag -c /var/flexlm/LicenseFile
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• (Linux) At a UNIX prompt, type:

/usr/aw/COM/bin/lmdiag -a -c /var/flexlm/
LicenseFile

• (Mac OS X) In a Terminal window, type:

/usr/aw/COM/bin/lmdiag -c /var/flexlm/LicenseFile

The format of lmdiag is:

Checking floating licensing with lmstat (IRIX, 
Linux, Mac OS X)

The lmstat tool reports the status of the license manager daemons 
and feature usage. It provides information about the status of the 
server nodes, vendor daemons, vendor features and users of each 
feature. lmstat is only useful for checking floating license errors. 
You must run lmstat on the license server machine.

To use lmstat 

1 Do one of the following:

• (IRIX) At a UNIX prompt, type: 

lmstat -a -c /var/flexlm/aw_servername.dat 

• (Linux) At a UNIX prompt, type:

/usr/aw/COM/bin/lmstat -a -c /var/flexlm/
aw_servername.dat 

• (Mac OS X) In a Terminal window, type:

/usr/aw/COM/bin/lmstat -a -c /var/flexlm/
aw_server.dat 

-c LicenseFile Specifies the license file to diagnose. 
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2 Press Return. The data is displayed on the screen.

When running lmstat, a lengthy list of status information 
appears. In short, the status information shows whether the 
license server is up and running, and whether each feature 
line in aw_servername.dat or aw_server.dat has no errors 
and the license count is correct. Examine the following entries 
in the status information for troubleshooting in the following 
steps:

lmstat - Copyright (C) 1989-2003 Macrovision 
Corporation. All rights reserved. 
Flexible License Manager status on Thu 5/15/2004 
10:51
License server status (License file: /var/flexlm/
aw_servername.dat):
servername: license server UP (MASTER)
Vendor daemon status (on servername):
sgiawd: UP

3 For the line that starts with License server status, make sure that 
the correct path to the license file is listed. If it is not the 
correct path, make sure that the license file exists in the /var/
flexlm/ directory, and make sure that the name of the server 
machine is correct.

4 The next line of status information shows if the license server 
is UP. If it is not UP, the error message printed is:

License server status (License file: /var/flexlm/
aw_servername.dat):
servername: Cannot connect to license server (-

-a Displays all. A lot of information appears if 
there are a lot of active users. 

-c license file This ensures that you are checking the 
diagnostics for the correct license file. 
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15,12:146) Connection refused
Vendor daemon status (on servername):
sgiawd: Cannot connect to license server (-
15,12:146) Connection refused

If this is the message you receive, follow these steps 
sequentially:

5 Confirm that the license server is up. 

For more information, see ”Additional setup for floating 
licenses” on page 111. Follow the platform-specific 
instructions for the license server you are working with.

6 Below the status information is a list of features in the 
aw_servername.dat or aw_server.dat file and information 
explaining whether the clients can use the features. An 
example follows:

Feature usage info:
Users of MayaUnltdf: (Total of 3 licenses 
available)

This example indicates that three floating Maya Unlimited 
licenses are available. 

If the aw_servername.dat or aw_server.dat file has a typing 
error, you’ll see something similar to this example:

Users of MayaUnltdf: (Error: 3 licenses, 
unsupported by licensed server)

Check aw_servername.dat or aw_server.dat for a typing 
error.

7 If following the above procedures does not solve the problem 
and successfully license Maya, gather all of the diagnostic 
output messages, the aw_servername.dat or aw_server.dat 
file, and the aw_flexlm.log file (located in /usr/tmp). 
Contact our Support Services department and provide them 
with this information.
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Checking for licensing errors with FLEXlm 
licensing utilities (Windows)

Licensing sometimes fails because your licensing software is using 
the wrong hardware ID (also known as Host ID or Server Host 
ID) for the hardware lock plugged into your node-locked or 
license server computer. The Host ID/Server Host ID for a 
hardware lock is printed on a sticker on the lock.

For node-locked or floating licenses, you can use the FLEXlm 
licensing utilities to check that your licensing software is using the 
correct hardware ID. For floating licenses only, you can 
additionally use the FLEXlm licensing utilities program to check 
for errors not listed in ”Understanding log file error messages” on 
page 140.

Do the following steps on the license server computer or on a 
computer that has a node-locked license.

To check for license errors (Windows)

1 On the machine you want to license, go to Start > Program 
Files > Alias > Common Utilities > FlexLM License Utilities.

2 In the LMTOOLS window, click the System Settings tab.

3 Record the FLEXID value, if shown. Otherwise, record the 
Ethernet Address value. 

The value you record is your hardware ID. 

4 In Notepad, open your license file (C:\FlexLM\aw.dat or 
aw_servername.dat). 

Tip The FLEXlm Licensing Utilities are located at 
<drive>:\Program Files\Common Files\

Alias Shared\Licensing\bin\lmtools.exe
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5 Depending on your license type, check the following:

(Node Locked License) Find "HOSTID=" in your license file 
and compare it to your recorded system ID.

(Floating License) Find "SERVER servername hostID 7111" in 
your license file and compare it to your recorded system ID. 
(Where HOSTID may either be a FLEXID or ethernet 
HOSTID.)

If these ID numbers do not match, make sure that you 
installed the correct license. Otherwise, you need to obtain a 
new license for your recorded System ID.

 

If you are checking for floating licensing errors, do the 
following:

6 Click the Server Status tab.

7 Select Display Everything.

8 Click Perform Status Enquiry.

9 Examine the status information that appears. For example:

License server status: 7111@servername
License file(s) on servername: 

C:\FLEXLM\aw_servername.dat:
servername: license server UP (MASTER) \

Vendor daemon status (on servername):
sgiawd: UP 

where servername is the name of the license server computer. 

Note A Host ID that contains FLEXID=7-0 or FLEXID=6-0 
means the hardware lock is not plugged into the parallel 
connector correctly.
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The status information shows whether the license server is up 
and running, and whether each feature line in 
aw_servername.dat has no errors and the license count is 
correct. 

The types of status information are as follows:

License server status—The number 7111 is a fixed number 
that represents the TCP port used internally by the licensing 
software. If you see a number other than 7111, make sure that 
you intend for that port number to be used. Otherwise, open 
the file aw_servername.dat and change the number to 7111.

License file(s) on servername—Check that the path to the 
license file is correct. 

servername—The next line of the status information shows the 
license server is up. If the license server isn’t up, you’ll see an 
error message that begins like this: 

lmgrd not running: Cannot connect to license 
server.
The server (lmgrd) has not been started yet, or 
the wrong port@host or license file is being used, 
or the port or hostname in the license file has 
been changed...

If you see this message, confirm the license server is up and 
ensure the pathname to the server’s aw_servername.dat file 
is correct.

Vendor daemon status (on servername)—The final two lines 
show whether the vendor daemon is up. The vendor daemon 
connects the license server to an application, in this case 
Maya. You can’t directly start the vendor daemon when it’s 
down. When you stop and start the license server software, 
the daemon starts also. If the license server is down, stop and 
start the license server software as described in ”Additional 
setup for floating licenses” on page 111. If the problem 
persists, restart the license server computer.
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Other information—Below the status information is a list of 
features in the aw_servername.dat file and whether the 
clients can use the features. An example follows:

Feature usage info:
Users of MayaUnltdf: (Total of 3 licenses 
available)

This example indicates that three floating Maya Unlimited 
licenses are available. 

If the aw_servername.dat file has a typing error, you’ll see 
something similar to this example:

Users of MayaUnltdf: (Error: 3 licenses unsupported 
by license server)

Check aw_servername.dat for a typing error.

10 If doing the following procedure doesn’t fix the problem, call 
Alias Support and keep the information from the preceding 
steps handy. 

Checking that a license file is the correct file 
type (Windows)

The aw.dat or aw_servername.dat file must be a .dat or FLEXlm 
license file. The following procedure shows how to check and 
correct the file type.

To check and correct the file type

1 From My Computer or Windows Explorer, right-click aw.dat 
or aw_servername.dat and select Properties from the pop-up 
menu.

2 In the Properties window, check that the file type is either 
.dat or FLEXlm License file. 

3 If not, select Tools > Folder Options.

4 Select the View tab. 
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5 Turn off Hide file extensions for known file types and click 
OK. You’ll likely see that aw.dat or aw_servername.dat file 
has an extension other than .dat, for example, .txt.

6 Right-click the filename and select Rename from the pop-up 
menu. 

7 Change the file extension to .dat.

You’ll be prompted that if you change a filename extension, 
the file may become unusable.

8 Click Yes. (The file won’t become unusable.)

The file now has the correct .dat extension for licensing 
operation.

Enabling a superuser (su) account 
(Mac OS X)

In Mac OS X, there are two levels of security: 

• Administrator Password Account. Your primary account has 
administrative privileges. This password allows you to install 
software. 

• Root Account. This special account will allow you to be a 
“super user”. You must have root user to start the license 
server for Maya on Mac OS X.

Note Using root makes it very easy for an inexperienced user 
to damage or destroy important data; please use su and 
sudo with caution and read the appropriate Apple 
documentation. Please check the Apple Support Web 
site - Article 106290 for a description of a root user in 
Mac OS X.
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To enable a root user in Mac OS X

1 Open Netinfo Manager (Applications > Utilities >Netinfo 
Manager).

2 Select Security > Authenticate.

A dialog box appears, asking for your Administrator 
password.

3 Enter your Administrator password.

4 Select Security > Enable Root User.

5 Click OK in the dialog box that appears.

6 Enter your password for root access. Re-enter your password 
for confirmation.

7 To confirm that you have set up superuser correctly, close 
Netinfo Manager and go to a Terminal window.

8 Type su.

9 Type in your password.

(When you type in your password it will not display on the 
prompt line in the terminal window.)

10 Type whoami. The response should be root.

Understanding licenses

This section explains the structure of the license Alias sends you. 
Understanding this structure is helpful if you manually entered 
the license into a text file from fax or mail and you’re looking for a 
typing error. A license can include multiple software components 

Note If the menu item says Disable Root User, your root 
account is already set.
Installation and Licensing Guide 

154



8 | Troubleshooting

 > Understanding licenses
and copies of Maya. The term license therefore refers to an entire 
license or an individual entry of a license, depending on the 
context.

Node-locked licenses

If you order node-locked licenses, you receive one license for 
every machine. The contents of the e-mail, fax, or mail depends on 
the Maya package you order. The following figure shows the 
structure of a node-locked license:

Feature Name—the Maya product package you purchased. 

License Version—the version number of the Maya package. 

Expiration—when the license expires. The word “permanent” 
means there is no expiration date. Product pre-release licenses 
have expiration dates. 

License Count—node-locked licenses have “uncounted” here, 
meaning that they do not have a license count. 

Password—an encrypted string that authenticates the license. 

Tip If you see a line near the top of your license that starts 
with SERVER, you’re installing floating licenses. 
Otherwise, you’re installing node-locked licenses. 

Feature 

Name 
License 

Version Password

Host ID/hardware IDVendor String

FEATURE MayaUnltd sgiawd 6.500 permanent uncounted 1234567890ab\
VENDOR_STRING=xxx HOSTID=690c5c73 

Expiration

License 

Count
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Vendor String—indicates you have a timed-out, pre-release, or 
educational license. If not present, it means that you have a 
purchased, permanent license. 

Host ID—also known as hardware ID. The Host ID of the 
machine to be licensed, the ethernet address of the machine or 
your computer’s system ID, obtained either from your Ethernet 
card or from a hardware lock (dongle) attached to your machine 
(Windows only).

Floating licenses

If you order floating licenses, you receive a single license for the 
license server computer. The contents of the e-mail, fax, or mail 
you receive depends on the Maya features you order. 

The following figure shows the structure of a floating license:

server—a placeholder where you must insert your actual server 
name. 

Server Host ID—Also known as hardware ID. This is one of the 
server’s host ID, the server’s Ethernet address, or the computer’s 
system ID, obtained either from the MAC Address of your 

Server 

Password

License
Version

Host ID
Your server

name here 

License 

Expiration

Count

Port 
Number

SERVER server FLEXID=7-b2854a12 7111
VENDOR sgiawd /usr/aw/COM/etc/sgiawd
FEATURE MayaUnltdf sgiawd 6.500 permanent 1 432B9293FFAD3F3726A6 \

SUPERSEDE="MayaUnltdf" \
ISSUED=6-jun-2004
VENDOR_STRING=xxx 

Vendor 
String

Feature 
Name
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Ethernet card or from a hardware lock (dongle) attached to your 
machine (Windows only; hardware lock server host IDs begin 
with FLEXID).

Port Number—a fixed number that represents the TCP port used 
internally by the licensing software.

Feature Name—the Maya product package you purchased. There 
may be several additional feature lines in your license; for 
example, the Maya Unlimited package includes separate lines for 
several different Maya Unlimited features. 

Vendor String—indicates you have a timed-out, pre-release, or 
educational license. If not present, it means that you have a 
permanent license. 

License Version—the version number of the software. 

Expiration—when the license expires. The word “permanent” 
means there is no expiration date. Product pre-release licenses 
have actual expiration dates. 

License Count—the number of floating licenses you ordered.

Password—an encrypted string that authenticates the license. 

Issue Date—the date the license was generated for the customer.

SUPERSEDE—overrides any license whose ISSUED date is less 
than the new ISSUED date.

Additional resources

• www.alias.com provides information on various Alias and 
Maya issues.

• www.alias.com/eng/support/maya/ is a direct link to the 
Maya support site
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• www.alias.com/eng/support/maya/faqs-tutorials/ provides 
Maya-specific Frequently Asked Questions and Web-based 
Tutorials

• www.macrovision.com/services/support/
software_licensing.shtml provides information on licensing.
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and conditions
Alias Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY

ALIAS (DEFINED BELOW) IS WILLING TO LICENSE THE 

SOFTWARE (DEFINED BELOW) ONLY TO THE CUSTOMER 
(DEFINED BELOW) AND ONLY IF ALL OF THE TERMS 

CONTAINED IN THIS SOFTWARE LICENSE AGREEMENT ARE 

ACCEPTED BY THE CUSTOMER.  BY INSTALLING AND/OR 
USING AND/OR OTHERWISE ACCESSING THE SOFTWARE, THE 

CUSTOMER EXPRESSLY ACKNOWLEDGES AND AGREES THAT 
IT SHALL BE BOUND BY THE TERMS CONTAINED HEREIN.

Article 1 -  Definitions

a) "Activation Date" means the date upon which the Software shall be 

deemed to be activated, which shall be the earlier of: (i) the date upon 
which Alias or Reseller provides the Enabling Mechanism to 

Customer; (ii) the date upon which Alias provides the Enabling 

Mechanism to Reseller for delivery to Customer; or (iii) the ninetieth 
(90th) day following Delivery;

b) "Agreement" means this Alias Software License Agreement; 

c) "Alias" means Alias Systems Corp.;

d) "Customer" means the end user of the Software that acquires the 
License pursuant to this Agreement, as identified on the Order;

e) "Delivery" means delivery of the media upon which the Software is 

provided to a carrier by Alias, its supplier, representative, agent or 

fulfillment services provider for carriage to Customer, or, where the 
Software is to be delivered via download, at such time when the 

Software is made available to Customer for download;

f) "Enabling Mechanism" means a mechanism by which the Software 
is activated or by which Customer can activate the Software; 

g) "License" shall have the meaning ascribed thereto in Article 2.a);

h) "Licensed Material" means the Software and the Materials;

i) "Materials" means any and all documentation and/or material 

provided to Customer by Alias or Reseller in relation to the Software;

j) "Order" means either: (i) the purchase order of Customer relating to 
the acquisition of one or more Licenses, which has been accepted by 

Alias or by a Reseller in Alias' or Reseller's sole discretion, as 
applicable; or (ii) a quotation that has been issued by Alias or a 

Reseller in respect of the acquisition of one or more Licenses, which 
has been accepted by Customer in accordance with and subject to its 

terms;

k) "Original Site" means the Customer site identified on the Order; 

l) "Proprietary Material" means the Software and the Materials, 
including any portion thereof in any embodiment, including copies 

thereof, and any other information or data relating to the Software, in 

written, graphic, or machine readable form, received by Customer 

from Alias or from a Reseller, including, but not limited to, designs, 

improvements, concepts and ideas, provided, however, that 
Proprietary Material does not include information and/or data that is 

rightfully in Customer's possession prior to its receipt from Alias or 
Reseller;

m) "Reseller" means an authorized reseller of Alias, which has been 

authorized to distribute Software within the territory in which the 
Original Site is located;

n) "Software" means the Alias software product(s), in object code 

form, described on the Order and provided to Customer pursuant to 

this Agreement and shall include any and all updates or upgrades 
thereto subsequently acquired by or provided to Customer;

o) "Third Party Material" means any software and/or documentation 

and/or material provided to Customer with the Software or in relation 
thereto, which has been produced and/or licensed by a third party and 

subsequently provided and/or made available and/or licensed to Alias 
by such third party for inclusion with the Software; 

p) "Training Programs" is defined in Article 9; and

q) "Warranty Period" means the period commencing upon Delivery 

and ending upon the earlier of: (i) the thirtieth (30th) day after the 
Activation Date; or (ii) the ninetieth (90th) day after Delivery.

Article 2 -  License and Software Rights

a) License Grant. Alias has granted to Customer and Customer has 

accepted, a non-exclusive, non-transferable, non-sublicensable, 
limited license to use the Licensed Material, subject to the terms and 

conditions of this Agreement (the "License"). 

b) Initial Hotline Support and Maintenance. Alias may, from time to 

time, elect to provide a period of initial hotline support services (which 
expressly excludes, without limitation, access to updates or upgrades 

of the Software) to Customer following acquisition of Software. Alias 
reserves the right to amend or terminate such policy at any time in its 

sole discretion, without notice. Alias' current policy is that, for a period 
of thirty (30) days from the Activation Date, Alias shall provide 

Customer with access to Alias' hotline support services in relation to 

the Software, where available. Unless Customer otherwise purchases 
support or maintenance services from Alias or a Reseller and with the 

sole exception of the above-noted temporary access to the hotline, 
Customer shall not be entitled to any form of support services, 

software maintenance services or products relating to the Software. 

Notwithstanding the foregoing, in the event that Customer acquires a 
Software support or maintenance contract contemporaneously with its 

acquisition of the Software, such support or maintenance contract 
shall commence on the earlier of: (i) the Activation Date of the 

Software being supported or maintained; or (2) any commencement 
date expressly identified on the applicable Order. 
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c) Installation Location. Use of the License shall be limited to the 

Original Site or any other Customer site within five (5) kilometers of 

the Original Site. In the case of a "floating" or "network" License, 
Customer may install the Software on one local area network at the 

Original Site and Customer may simultaneously operate multiple 
copies of the Software on any computer directly connected to the 

applicable file server, provided the number of copies of the Software 

operating simultaneously does not exceed the total number of floating 
Licenses acquired by Customer and further provided the users 

accessing the Software through the network are no farther than five 
(5) kilometers from the applicable network server. Relocation of the 

Software may only be done with the express prior written consent of 
Alias.

d) Licenses Non-Transferable. It is expressly acknowledged and 

agreed the License is non-transferable and Customer shall not purport 

to assign or transfer the License without the prior written consent of 
Alias, which may be granted or withheld in Alias' sole and absolute 

discretion. Any such purported transfer or assignment in the absence 
of Alias' prior written consent shall be void and without effect. If such 

transfer is authorized, Customer agrees to provide any and all 
information reasonably requested by Alias relating to such transfer 

and Customer shall promptly execute and/or have executed by the 

proposed transferee any and all documentation provided by Alias 
required to effect such transfer.

e) Back-Up Installations. In the event of a major malfunction causing 

the specified computer hardware on which the Software has been 
installed to become inoperable for an extended period of time, 

Customer may install the Software on a back-up system on a 

temporary basis during such malfunction. Customer agrees to 
promptly notify Alias of any such back-up use and specify the location 

of the back-up system. 

f) Internal Use Only. Customer may use the Software only in 
connection with operation and management of Customer's own 

internal business, subject to the terms hereof. Customer is not 
authorized to grant sublicenses to use the Software nor to permit 

other persons to use the Software on a time-sharing or any other 

basis.

g) Customer Responsibilities. Customer shall be exclusively 

responsible for the supervision, management and control of its use of 

the Software, including, but not limited to: (i) selection of the Software 
to achieve Customer's intended results; (ii) determining the 

appropriate use and establishing the limitations of the Software in 
Customer's operations; (iii) assuring operation of the Software by 

qualified, trained personnel, in the specified computer environment, 

including proper machine hardware configuration and operating 
system software; (iv) assuring proper operating methods; (v) 

establishing adequate back-up plans to prevent loss of data in the 
event of a malfunction of the Software; and (vi) implementing 

sufficient procedures and checkpoints to satisfy its requirements for 
security and to assure accuracy of input and output. 

h) License Termination on Non-Payment. Alias reserves the right to 

disable the Software and/or terminate the License upon written notice 

if Customer fails to pay either Reseller or Alias for the License 
pursuant to the terms of the Order. 

Article 3 -  Protection of Proprietary Material

a) Ownership. Alias and/or its suppliers and/or its licensors retain all 

right, title, and interest in and to all Proprietary Material (including, 

without limitation, all rights under any applicable copyrights, patents, 
trademarks and trade secrets) and to all copies thereof made by 

Customer. 

b) Reverse Engineering. Customer shall not reverse compile, reverse 
engineer or disassemble the Software, except to the extent that Alias 

is not permitted by law to exclude or limit such rights. Customer shall 
not use the Software for the purpose of developing, modifying or 

improving a software product without the express prior written consent 

of Alias.

c)  Proprietary Material Confidential. Customer acknowledges the 

Proprietary Material is confidential and constitutes a valuable asset of 

Alias and/or its suppliers and/or licensors and shall not disclose, 
publish, display or otherwise make available to any persons any of the 

Proprietary Material or copies thereof without Alias' prior written 
consent. 

d) Limitation on Reproduction. Customer shall not copy or reproduce 

any of the Proprietary Material, except: (i) in the ordinary course of 
exercising its rights hereunder; (ii) for back-up purposes; or (iii) with 

the express prior written consent of Alias. 

e) Limitation of Access, Disclosure and Use. Customer shall not use 

any Proprietary Material for any purpose not specifically authorized in 
this Agreement. Customer shall limit the use of and access to the 

Software and other Proprietary Material to its bona fide employees 
and/or consultants whose use of or access to such Proprietary 

Material is necessary to Customer's use of the Software (in 

accordance with the terms hereof) and Customer shall take 
appropriate action, by agreement, instruction or otherwise, to protect 

the Proprietary Material from unauthorized publication, disclosure or 
use. 

f) Notices. Customer shall not remove any copyright, intellectual 

property or proprietary rights notice(s) included in or on any 
Proprietary Material and shall reproduce all such notices on any 

permitted copies made of any Proprietary Material. 

g) Inspection. Alias shall have the right to inspect, upon reasonable 
prior notice and during normal business hours, any Customer location 

at which any Proprietary Material is used or kept to ensure or confirm 

compliance with the terms of this Agreement.

h) Irreparable Harm. Customer acknowledges and agrees that in the 
event of any breach of its obligations under this Article, Alias will 

suffer irreparable harm of a nature that is not compensible by 
damages and Alias shall be entitled to seek injunctive or other 

equitable relief on an expedited basis.

Article 4 -  Warranty and Liability

a) Limited Warranty. During the Warranty Period and subject to the 
provisions of this Article, Alias warrants as follows: (i) the media upon 

which the Software is provided to Customer, if any, shall be free of 
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material defect; and (ii) the Software shall reasonably conform to the 

specifications contained in the Software documentation furnished to 

Customer.

b) Remedies. Alias' sole responsibility under the limited warranty 
provided for in Article 4a) shall be, at its election, to: (i) replace the 

media upon which the Software has been provided to Customer, 
provided that Customer first returns the allegedly defective media to 

Alias; (ii) correct or replace the Software or that portion of the 
Software that fails to conform with the provided specification; or (iii) 

refund the purchase price paid by Customer for the License. 

c) Disqualifying Events. Customer acknowledges and agrees the 

limited warranty provided in Article 4a) shall be invalidated and 
Customer shall have no claim whatsoever thereunder if: (i) Customer 

fails to report in writing to Alias any defect or error claimed to be a 
breach of warranty during the Warranty Period; (ii) the Software or the 

media upon which the Software is provided is misused; (iii) the 
Software or the media upon which the Software is provided is 

damaged, altered or affected by accident, neglect, misuse or other 

abuse; (iv) the claimed defect or error has been caused, in whole or in 
part, by persons other than Alias; or (v) if the Software has been 

installed on a system that has not been certified by Alias as 
compatible with the Software at the time of acceptance of the Order. 

d) THE LIMITED WARRANTY SET FORTH IN THIS ARTICLE 4 IS 

THE ONLY WARRANTY MADE BY ALIAS WITH RESPECT TO THE 
SOFTWARE AND/OR THE LICENSE. ALIAS MAKES NO OTHER 

WARRANTIES, EXPRESS, IMPLIED OR ARISING BY CUSTOM OR 

TRADE USAGE, AND TO THE EXTENT PERMITTED BY 
APPLICABLE LAW, SPECIFICALLY DISCLAIMS ANY IMPLIED 

WARRANTIES OF TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

e) IN NO EVENT SHALL ALIAS' AND/OR ALIAS' AFFILIATES' 

TOTAL AGGREGATE LIABILITY ARISING OUT OF OR RELATING 

TO THIS AGREEMENT, THE LICENSED MATERIAL AND/OR THE 
LICENSE EXCEED THE AMOUNT ACTUALLY PAID BY 

CUSTOMER FOR THE LICENSE HEREUNDER. IN NO EVENT 
SHALL ALIAS BE LIABLE TO CUSTOMER FOR SPECIAL, 

CONSEQUENTIAL, INCIDENTAL, INDIRECT, PUNITIVE OR 
EXEMPLARY DAMAGES, HOWEVER CAUSED, WHETHER FOR 

BREACH OF WARRANTY, CONTRACT, TORT, NEGLIGENCE, 

STRICT LIABILITY OR OTHERWISE, INCLUDING WITHOUT 
LIMITATION ANY CLAIMS RELATING TO LOST PROFITS, 

BUSINESS OR OPPORTUNITIES, EVEN IF ALIAS HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN 

IF SUCH DAMAGES WERE FORESEEABLE. 

Article 5 -  Intellectual Property

Alias shall defend or, at its option, settle, any claim or proceeding 
brought against Customer to the extent that it is based on an 

assertion the Customer's authorized use of the Software constitutes 

direct infringement of any Canadian or United States copyright or 
patent(s) registered on or before the date of the Order, and shall 

indemnify Customer against all reasonable costs, damages and 
expenses finally awarded against Customer which result from any 

such claim, provided that Customer notifies Alias promptly in writing of 

any such claim or proceeding and gives Alias full and complete 

authority, information and assistance to defend such claim or 
proceeding and all negotiations for a compromise or settlement. Alias 

shall have no liability or obligation to Customer hereunder for any 
patent or copyright infringement or claim thereof based upon: (i) the 

combination of the Software with other products not furnished by 

Alias; (ii) any addition to or modification of the Software made after 
installation by any person or entity other than Alias; or (iii) any 

software or other technology not claimed to be owned by Alias, 
including without limitation the Third Party Material. Alias shall have 

no obligation hereunder for any costs incurred by Customer without 
Alias's express prior written authorization. If the Software or any part 

thereof becomes, or in Alias's opinion is likely to become, the subject 

of a claim of infringement, Alias shall have the right, at Alias's option 
and expense, to (i) procure for Customer the right to continue using 

the Software, (ii) replace or modify the Software so that it becomes 
non-infringing, or (iii) refund the amounts actually paid to Alias by 

Customer for the License, less a reasonable allowance to provide for 

use of the Software by Customer prior to the date of the refund. The 
provisions of this Article state the sole, exclusive and entire liability of 

Alias and the sole, exclusive and entire remedy of Customer, with 
respect to any claim of patent or copyright infringement with respect to 

the Software, and any part thereof. 

Article 6 -  Term and Termination

a) Term. This Agreement takes effect on the date on which the Order 
is received and accepted by Alias or a Reseller and shall remain in 

effect unless terminated as provided herein. Notwithstanding the 

foregoing, in the event the Software is provided to Customer for 
evaluation and/or demonstration purposes, this Agreement shall be 

effective from the date such Software is provided to Customer until 
the date of termination of such evaluation or demonstration, as 

determined by Alias in its sole and absolute discretion.

b) Termination. If Customer shall fail to perform or be in breach of any 
of its obligations hereunder, Alias may terminate this Agreement and 

the License provided hereunder, by giving written notice of termination 

to Customer, which shall be effective immediately upon its sending. 
This Agreement and the License granted hereunder shall terminate 

automatically and without notice if Customer should cease to carry on 
its business as a going concern in the ordinary course, including any 

act or omission constituting bankruptcy, the appointment of a trustee, 
liquidator or receiver for the assets of Customer, or the taking 

advantage of any legislation providing protection of Customer from its 

creditors.

c) Consequences of Termination. Within five (5) days after any 
termination of this Agreement, Customer shall, at Alias' election, 

deliver or destroy all Proprietary Material, including all copies thereof, 
within its possession, custody or control. Customer shall delete or 

destroy any and all such Proprietary Material that is stored in any 
computer software or storage facility that, for any reason, cannot be 

delivered to Alias. Customer expressly represents and warrants that it 

shall delete or destroy any and all such information and data that is 
subsequently detected or discovered. An executive officer of 
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Customer shall certify in writing to Alias that all Proprietary Material 

has been so destroyed or returned.  Articles 1, 3, 4, 6.c), and 7 - 10 

hereof shall survive any termination of this Agreement.

Article 7 -  Government End Users 

This Article applies if the Software is acquired directly or indirectly on 

behalf of a unit or agency of the United States Government. For 

civilian agencies: the Software was developed at private expense and 
is "restricted computer software", submitted with restricted rights in 

accordance with subparagraphs (a) through (d) of the Commercial 
Computer Software - Restricted Rights clause of FAR 52.227-19 

(June 1987) and its successors; and it is unpublished and all rights 

are reserved under the copyright laws of the United States. For units 
of the Department of Defense (DoD), the Software is licensed only 

with "Restricted Rights" as that term is defined in the DoD 
Supplement to the FAR, clause 252.227-7014 (June 1995), Rights in 

Technical Data and Computer Software and its Successors (including 
clause 252.227-7014(b)(3) (1994)), and use, duplication or disclosure 

is subject to the restrictions set forth therein.

Article 8 -  Third Party Material

The parties hereto expressly acknowledge and agree that, 
notwithstanding any other provision hereof, Alias makes no warranties 

whatsoever with respect to the Third Party Material and Customer 

acknowledges and agrees that Customer's rights and obligations with 
respect to such Third Party Material may be governed by the terms of 

a separate and/or supplementary license agreement, which may be 
provided and/or made available by Alias. ALIAS MAKES NO 

WARRANTY OF ANY KIND WITH RESPECT TO THE THIRD 

PARTY MATERIAL, EXPRESS, IMPLIED OR ARISING BY CUSTOM 
OR TRADE USAGE, AND TO THE EXTENT PERMITTED BY 

APPLICABLE LAW, SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTIES OF TITLE, NON-INFRINGEMENT, 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

NOTWITHSTANDING ANY OTHER PROVISION HEREOF, TO THE 
EXTENT PERMITTED BY APPLICABLE LAW, NEITHER ALIAS NOR 

ITS AFFILIATES SHALL HAVE ANY LIABILITY WHATSOEVER 
ARISING OUT OF OR IN RELATION TO THE THIRD PARTY 

MATERIAL.

Article 9 -  Academic and Educational Licenses

If Customer acquired the Software pursuant to one of Alias' academic 
or educational access programs (including, without limitation, student 

and/or instructor access programs) as they may exist from time to 
time and which shall be defined by Alias in its sole discretion from 

time to time, the following additional restrictions apply: Customer shall 

use the Software for educational purposes only and under no 
circumstances shall Customer use or permit others to use the 

Software in any manner for a commercial purpose or in respect of a 
for-profit enterprise of any kind. If Customer is a training or 

educational institution or an instructor at such an institution and 

acquired the Software pursuant to an Alias program designed to 
afford access to such Software to enable Customer to train others to 

use the Software, then Customer shall use the Software for 
educational purposes only and only as incorporated into such training 

or educational programs or curricula (the "Training Programs"). For 

clarity, if the third parties being trained by Customer pursuant to the 

Training Programs pay to Customer a fee for such training, the receipt 

of such payment by Customer shall not in itself constitute a violation 
by Customer of the non-commercial use restrictions contained in this 

Article.

Article 10 -  General Provisions

a) Entire Agreement, Severance. This Agreement sets forth the entire 
agreement and understanding of the parties with respect to the 

subject matter hereof. Neither party shall be bound by or be liable for 
any alleged representation, promise, inducement or statement of 

intention not set forth herein and no waiver, alteration, modification, or 

cancellation of any of the provisions of this Agreement shall be 
binding unless made in writing and signed by the parties. Any 

provisions of the Order that are in any way inconsistent with or in 
addition to the terms and conditions of this Agreement shall not be 

binding upon Alias and Alias' failure to object to any such provision or 
processing or acceptance of such Order shall not be construed as a 

waiver of the terms and conditions of this Agreement nor as an 

acceptance of any such provisions. The failure of either party to 
require performance of any provision hereof shall not affect the right 

at a later time to enforce such provision. In the event that one or more 
of the provisions contained in this Agreement shall for any reason be 

held invalid, illegal or unenforceable in any respect, no other 

provisions contained in the Agreement shall be affected.

b) Evaluation or Demonstration Licenses. In the event the Software is 

provided to Customer for evaluation and/or demonstration purposes, 

Articles 2b), 4a), 4b), 4c) and 5 shall not apply. All Software provided 
for evaluation and/or demonstration purposes is provided "as is" and 

without warranties of any kind.

c) Governing Law / Export. This Agreement shall be governed by and 
interpreted in accordance with the laws of the Province of Ontario and 

the federal laws of Canada applicable therein for purposes of any 

action commenced under this Agreement or with respect to any tort 
committed or alleged to be committed in the performance of this 

Agreement. No choice of law rules of any jurisdiction shall apply 
hereto. The parties hereto expressly waive any right they have to a 

jury trial and agree that any court proceeding under this Agreement 
shall be tried by a judge without a jury. Customer shall at all times 

comply with all Canadian, U.S., foreign and local export laws and 

regulations, as applicable, with respect to the acquisition, shipment or 
receipt of the Software.

d) Notices. Any notice or other document required or permitted to be 

given hereunder shall be validly given if delivered personally 
(including courier service) or by prepaid registered mail, return receipt 

requested or sent by facsimile transmission to the addressee thereof. 
Notices shall be deemed received three (3) days after mailing in the 

case of certified mail, and on the next business day in the case of 

courier delivery or facsimile transmission, except a notice of 
termination, which is governed by Article 6b). Notices shall be sent to 

Customer at the address specified on the Order. Notices shall be sent 
to Alias as follows: Alias Systems Corp., 210 King St. East, Toronto, 

Ontario, Canada M5A 1J7; Fax 416.369.6135; Attn: General Counsel.
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e) Headings. Article headings used in this Agreement are for 

reference purposes only and shall not be used in the interpretation of 

this Agreement.

f) Enurement. This Agreement shall be binding upon and inure to the 
benefit of the parties and their respective successors, permitted 

assigns and legal representatives, provided, however, the rights and 
obligations of Customer hereunder may not be assigned, sublicensed 

or otherwise transferred, in whole or in part, without the prior written 
consent of Alias, which may be granted or withheld by Alias in its sole 

and absolute discretion. This Agreement may be assigned by Alias 

without notice.

Vm6.5-12-04

MAYA® DOCUMENTATION SERVER LICENSE AGREEMENT

READ THIS AGREEMENT CAREFULLY. ALIAS SYSTEMS CORP. 

AND ANY THIRD PARTY LICENSORS WHOSE TECHNOLOGY IS 
INCORPORATED INTO OR PROVIDED WITH THE MAYA 

DOCUMENTATION SERVER ("ALIAS") IS WILLING TO LICENSE 

THE MAYA DOCUMENTATION SERVER ("SOFTWARE") TO YOU 
("CUSTOMER") ONLY ON THE CONDITION THAT ALL OF THE 

TERMS CONTAINED IN THIS LICENSE AGREEMENT ARE 
ACCEPTED.

YOU ACCEPT AND AGREE TO BE BOUND BY THIS AGREEMENT 

BY CLICKING THE ICON LABELED "I ACCEPT" THAT IS 
DISPLAYED BELOW. IF YOU DO NOT AGREE TO THIS 

AGREEMENT, CLICK THE ICON LABELED "CANCEL" TO CANCEL 

INSTALLATION.

1. Ownership and License. This is a license agreement and NOT an 
agreement for sale. As between Customer and Alias, Alias continues 

to own the Software and all intellectual property rights therein. 
Customer's rights to use the Software are specified in this Agreement, 

and Alias retains all rights not expressly granted to Customer in this 

Agreement. Nothing in this Agreement constitutes a waiver of Alias' 
rights under domestic, foreign or international law, or any other state, 

provincial, local, or regional law.

2. License to Software. Alias grants to Customer and Customer 
accepts, a non-exclusive, non-transferable license to use the Software 

during the term hereof, subject to the terms and conditions of this 
Agreement. Customer may use the Software only in connection with 

operation and management of Customer's own internal business. 

Customer is not authorized to grant sublicenses to use the Software, 
nor to permit other persons to use the Software on a time-sharing or 

any other basis without the prior written consent of Alias, which may 
be granted or withheld in Alias' sole discretion. 

3. Third Party Components. 

3.1. The Software is distributed with the following third party 

components/applications: (1) Lucene Search Engine Toolkit v1.3 
("Toolkit"); (2) Mozilla Rhino JavaScript Interpreter for Java v1.5 

("Rhino"); (3) Sun Microsystems' Java Runtime Environment v1.4; (4) 
Velocity 1.31 ("Velocity"); (5) log4j Lite 1.28 ("log4i Lite"); (6) Jazzy 

0.5 ("Jazzy"); and (7) Jakarta Oro 2.07 ("Jakarta Oro"). The foregoing 

applications are collectively referred to herein as "Third Party 

Components".

3.2. The Toolkit, Velocity, Jakarta Oro, and log4i Lite ("Apache-
Licensed Material") were developed by the Apache Software 

Foundation (http://www.apache.org/). (c) The Apache Software 
Foundation. All rights reserved. These applications consist of 

voluntary contributions made by many individuals on behalf of the 
Apache Software Foundation. For more information on the Apache 

Software Foundation, please see http://www.apache.org. 

Notwithstanding any contrary or inconsistent terms hereof, the 
Apache-Licensed Material is provided subject to the terms of the 

Apache Software License v.1.1, a copy of which can be found in the 
Software documentation and/or help server directory. 

3.3. Notwithstanding any contrary or inconsistent terms hereof, Jazzy 

is distributed subject to the GNU Lesser General Public License (a 
copy of which can be found in the Software documentation and/or 

help server directory) and WITHOUT ANY WARRANTY; without even 

the implied warranty of MERCHANTABILITY or FITNESS FOR A 
PARTICULAR PURPOSE.

3.4. Notwithstanding any contrary or inconsistent terms hereof, Rhino 

is provided pursuant to the terms of the Mozilla Public License 
Version 1.1 ("License") and is distributed on an "AS IS" basis, 

WITHOUT WARRANTY OF ANY KIND, either express or implied. 
(You may obtain a copy of the License at http://www.mozilla.org/MPL/

). See the License for the specific language governing rights and 

limitations under the License.

3.5. Subject to the foregoing, the Third Party Components are 
provided pursuant to this Agreement and Customer's use of the Third 

Party Components shall be governed by the terms and conditions 
hereof. 

4. Warranties. THE SOFTWARE IS PROVIDED AS IS. ALIAS DOES 

NOT WARRANT THAT THE SOFTWARE OR ANY COMPONENT 
THEREOF WILL MEET CUSTOMER'S REQUIREMENTS OR THAT 

ITS OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE. 

ALIAS MAKES NO WARRANTIES, EXPRESS, IMPLIED OR 
ARISING BY CUSTOM OR TRADE USAGE RELATING TO THE 

SOFTWARE OR ANY COMPONENT THEREOF, AND WITHOUT 
LIMITING THE GENERALITY OF THE FOREGOING, TO THE 

EXTENT PERMITTED BY APPLICABLE LAW, SPECIFICALLY 

DISCLAIMS ANY IMPLIED WARRANTIES OF TITLE, NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. TO THE EXTENT PERMITTED BY 
APPLICABLE LAW, ALIAS SHALL HAVE NO LIABILITY IN 

CONTRACT, TORT OR OTHERWISE ARISING OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THIS AGREEMENT. 

WITHOUT LIMITING THE GENERALITY OF THE FOREGOING, IN 

NO EVENT SHALL ALIAS BE LIABLE FOR ANY PUNITIVE OR 
MULTIPLE DAMAGES OR LOST PROFITS OR OTHER SPECIAL, 

DIRECT, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES, INCLUDING ANY DAMAGES RESULTING FROM LOSS 

OF BUSINESS ARISING OUT OF OR IN CONNECTION WITH THE 

PERFORMANCE OF THE SOFTWARE, EVEN IF ALIAS HAS BEEN 
PREVIOUSLY ADVISED OF THE POSSIBILITY OF SUCH 
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DAMAGES. CUSTOMER SHALL INDEMNIFY ALIAS AND ITS 

LICENSORS AND HOLD ALIAS AND ITS LICENSORS HARMLESS 

FROM AND AGAINST ANY LOSS, CLAIM OR DAMAGE TO ANY 
PERSON ARISING OUT OF OR RELATING TO CUSTOMER'S USE 

OF THE SOFTWARE.

5. Protection of Proprietary Material. For the purposes of this 
Agreement, "Proprietary Material" means the Software and any 

portion thereof in any embodiment, including copies thereof, and any 
other information or data, in written, graphic, or machine readable 

form, received by Customer from Alias, including, but not limited to, 

designs, improvements, concepts and ideas provided, however, that 
Proprietary Material does not include information and data which is 

rightfully in Customer's possession prior to its receipt from Alias, or 
which, other than through the fault of Customer, is or becomes 

available in the public domain. Alias and/or its suppliers and/or its 

licensors retain all right, title, and interest in and to all Proprietary 
Material (including, without limitation, all trade secrets and intellectual 

property rights therein) furnished by Alias and to all copies thereof 
made by Customer. Customer acknowledges that the Proprietary 

Material is confidential and constitutes a valuable asset of Alias and/or 
its suppliers and/or its licensors and shall not disclose, publish, 

display or otherwise make available to any persons any of the 

Proprietary Material or copies thereof without Alias' prior written 
consent. Customer shall not copy or reproduce any of the Proprietary 

Material, except for back-up purposes, or with the prior written 
consent of Alias. Customer shall not use any Proprietary Material for 

any purpose not specifically authorized in this Agreement. Customer 

shall limit the use of and access to the Software and other Proprietary 
Material to its bona fide employees or consultants whose use of or 

access to such Proprietary Materials is necessary to Customer's use 
of the Software and shall take appropriate action, by agreement, 

instruction or otherwise, to protect the Proprietary Material from 

unauthorized publication, disclosure or use. Customer shall not 
remove any copyright or proprietary rights notice included in any 

Proprietary Material and shall reproduce all such notices on any 
copies made of any Proprietary Material. Customer acknowledges 

and agrees that in the event of any breach of its obligations under this 
Section, Alias will not have an adequate remedy at law, and, 

therefore, injunctive or other equitable relief would be appropriate.

6. Term and Termination. This Agreement is effective until terminated. 

If Customer shall fail to perform or be in breach of any of its 
obligations hereunder, Alias may terminate this Agreement and the 

license granted hereunder, by giving written notice of termination to 
Customer effective immediately upon its sending. Customer may 

terminate this Agreement at any time by destroying all copies of the 
Software in Customer's possession and certifying in writing such 

destruction to Alias, or by returning all such copies to Alias. This 

Agreement and Customer's license and rights hereunder shall 
automatically terminate if Customer purports to assign this Agreement 

or the license granted hereunder to another party or breaches any of 
its obligations hereunder in respect of the Proprietary Material. Upon 

termination, Customer must immediately cease all use of the Software 

and deliver or destroy all Proprietary Material, including copies 
thereof, in its possession, custody or control, including information 

and data relating to the Software stored in any computer software or 

storage facility which for any reason cannot be delivered to Alias or 

which may be detected in the future on backup media. Sections 1, 

3.2-3.4, 4, 5, 6, 7 and 8 hereof shall survive any termination of this 
Agreement.

7. Government End Users-Restricted Rights Legend. If the Software 

is acquired directly or indirectly on behalf of a unit or agency of the 
United States Government and this provision applies. For civilian 

agencies: the Alias Software was developed at private expense and is 
"restricted computer software" submitted with restricted rights in 

accordance with subparagraphs (a) through (d) of the Commercial 

Computer Software - Restricted Rights clause of FAR 52.227-19 and 
its successors; and it is unpublished and all rights are reserved under 

the copyright laws of the United States. For units of the Department of 
Defense (DoD): the Alias Software is licensed only with "Restricted 

Rights" as that term is defined in the DoD Supplement to the FAR, 

clause 252.227-7013 (c)(1)(ii) (Oct. 1988), Rights in Technical Data 
and Computer Software and its Successors (including clause 

252.227-7014(b)(3) (1994)), and use, duplication or disclosure is 
subject to the restrictions set forth therein.

8. General Provisions. Customer acknowledges that the Software is 

subject to export control laws and regulations, including future 
amendments thereof ("Export Laws"). Customer shall not directly or 

indirectly purport to or transfer the Software in any manner in violation 

of any Export Laws. Customer shall indemnify Alias from and against 
any loss, claim or damage arising out of Customer's violation of the 

Export Laws. All written notices required hereunder shall be sufficient 
if sent by certified or registered mail, postage prepaid, addressed to 

the address provided by Customer prior to accessing the Software. 

This Agreement sets forth the entire agreement and understanding of 
the parties with respect to the subject matter hereof, and supersedes 

all prior oral and written agreements and understandings relating 
thereto. Neither party shall be bound by or be liable for any alleged 

representation, promise, inducement or statement of intention not set 
forth herein and no waiver, alteration, modification, or cancellation of 

any of the provisions of this Agreement shall be binding unless made 

in writing and signed by the parties. The failure of either party to 
require performance of any provision hereof shall not affect the right 

at a later time to enforce such provision. No remedy referred to in this 
Agreement is intended to be exclusive, but each shall be cumulative 

and in addition to any other remedy referred to herein or otherwise 

available at law or in equity. In the event that one or more of the 
provisions contained in this Agreement shall for any reason be held 

invalid, illegal or unenforceable in any respect, no other provisions 
contained in the Agreement shall be affected. This Agreement shall 

be governed by the substantive law of the Province of Ontario, 
Canada, without regard to its conflicts of law principles, and not by the 

1980 United Nations Convention on Contracts for the International 

Sale of Goods, as amended. This Agreement shall be binding upon 
and enure to the benefit of the parties and their respective 

successors, assigns and legal representatives, provided, however, 
that the rights and obligations of Customer hereunder may not be 

assigned, sublicensed or otherwise transferred in whole or in part, 

without the prior written consent of Alias.

VM6.5-12-04
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